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Introduction

Paragon Partition Manager™ 11 Professional is an integrated set of powerful tools that is specially designed to tackle

most of the problems you might face while using PC. A highly intelligent program engine together with built-in advanced

recovery facilities make it possible to securely carry out partitioning operations of any complexity, optimize

performance of NTFS and FAT file systems, migrate the system to another hard disk, etc. without fear to lose precious

data.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

A

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Partition Manager

The updated P2V Copy/Restore Wizards to migrate a Windows physical system (live or from a Paragon’s

backup) to a virtual environment of one of the supported virtualization software vendors. In the latest version
of the product the wizards enable to:

- Create and properly configure virtual machines according to your preferences. Depending on the selected
virtualization vendor you’ve got the option to specify a version of the future virtual machine, its name,
location, RAM to allocate, a disk controller, the guest OS, etc. So when the migration is over, you’ll get not
only a virtual disk that contains an operating system and/or data, but a ready-to-use virtual machine.

- Convert any combination of hard disks and partitions to migrate your entire computer or certain partitions
in one operation. Complex backups that contain partitions from different hard disks are supported as well.

- Employ MS VSS (Volume Shadow Copy Service) to synchronously migrate from several hard disks, thus
ensuring data consistency during online migration of a system, which seats on several partitions or hard
disks. This is achieved by taking a point-in-time snapshot of the whole disk subsystem.

- When migrating from several hard disks, all their signatures will be kept intact, so you’ll get the same drive
letters in a virtual environment.

The updated P2V Adjust OS Wizard allows creation of virtual machines as well, so besides its primary function,

you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images.
Connect VD to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available

for physical disks to virtual. You’ve now got the option to:

- Mount a virtual disk in the read-only mode to make sure no data will be changed on the virtual disk during
copy or any other operation on it.

- Support for VMware ESX Server’s export format to copy/retrieve data from virtual machines of this vendor.
It’s useful for offline V2V and V2P operations.

The updated P2P Adjust OS Wizard to successfully start up a Windows physical system on a different hardware
platform (P2P) by allowing injection of all required drivers and the other actions crucial for this type of

migration. Including the third generation of Paragon’s Adaptive Restore™ technology, it now can:

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



8
- Analyze all installed drivers inside a target system to report on devices without drivers.
- Search for and install lacking drivers from the built-in Windows repository.

- Notify the user about boot critical devices without drivers (HDD/RAID controllers, etc.), automatically
prompting to provide a path to a driver repository.

- Name all devices according to their model description, not some alphanumeric code, which requires
additional deciphering.

- Determine and install drivers not only for boot critical devices, but for physically connected NICs as well.
e Automatic partition alignment during partitioning/copy operations to optimize performance of your hard disk.

o Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation

performance and the risk of data loss.

e WinPE 3.0 based bootable environment to enjoy support of a wider range of hardware configurations with the

option to add drivers for specific hardware on-the-fly.

o The updated Boot Corrector for WinPE that now equals the functionality of the Linux/DOS counterpart.

e Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows
native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit
Windows.

e AFD (Advanced Format Drive) ready.
e Support of 2TB+ and non-512B sector size drives.

e USB 3.0 ready.

Product Components
In order to cope with different tasks, the product contains several components:

e Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

e Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both
platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB
devices. It enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware.
DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP
like environment.

e WinPE based recovery environment. Especially for keen followers of Windows, our product also offers a WinPE

3.0 based bootable media. Unlike the Linux/DOS recovery environment it can boast an excellent hardware
support and the same interface as the Windows version can. However its system requirements are much
tougher.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.
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Features

Let us list some of the features:

User Friendly Fault Minimizing Interface

Graphical representation of the data to gain a better understanding.

A handy Launcher to easily find and run the required tasks.

Comprehensive wizards to simplify even the most complex operations.
Resize partitions directly on the Disk Map with the drag-and-drop technique.
A context sensitive hint system for all functions of the program.

Previewing the resulting layout of hard disks before actually executing operations (so-called virtual

operations).

Backup Facilities

Available location for backup images:

- Backup to local mounted partitions.
- Backup to local unmounted (without drive letter assigned) partitions.

- Backup to an external mounted storage to provide for a higher level of data protection and system
independence.

- Backup to a special secured place on the hard disk called the Backup Capsule that has an independent system
layout (e.g. a separate partition) and will stay operable should the active file system be damaged. To avoid an
accidental removing or unauthorized access of the backup data, this partition is hidden and thus cannot be
mounted in the operating system.

- Backup to external media (CD/DVD) to guarantee a high level of data protection as long as the backup media is
kept secure.

- Backup to a network drive to stand a better chance of success in case of a hard disk failure.

Restore Facilities

Restore an entire disk, separate partitions or only files you need from the previously created backup image.

Restore with Shrink to restore a backup image to a free block of smaller size taking into account only the
amount of actual data of the image.

Adaptive Restore to successfully migrate a Windows physical system to a different hardware platform (P2P) by
allowing automatic injection of all required drivers and the other actions crucial for a migration of this kind.

Copy Facilities

Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and

other system service structures, thus maintaining the operating system’s working capability.

A Copy functionality can also be used as an alternative way of data protection.
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Virtualization Facilities

e Connect VD to connect a virtual disk as if it’s an ordinary physical disk, thus opening up all functionality available
for physical disks to virtual.

e P2V Copy to migrate a Windows physical system to a virtual environment in the online mode.

e P2V Restore to migrate a Windows physical system backed up with a Paragon disaster recovery tool to a virtual
environment.

e P2V Adjust to recover the startup ability after unsuccessful virtualization with a 3rd party tool.

A Virtualization is the latest trend in the system migration, protection, and evaluation.

Boot Management Facilities

e Boot Manager Setup Wizard to easily manage several operating systems on one computer.

Partition/Hard Disk Management Facilities

e Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the
standard Windows disk tools, the program supports all popular file systems.

e Express Create Partition Wizard to create a new partition in the most appropriate place of a hard disk, format it
to NTFS and then make it available in the system by assigning a drive letter.

e Merge Partitions Wizard to consolidate the disk space, which originally belongs to two adjacent partitions
(NTFS, FAT16/FAT32), into a single, larger partition.

e Redistribute Free Space Wizard to increase free space on one partition by up-taking the on-disk unallocated

space and the unused space of other partitions.

o Express Resize Partitions Wizard to increase free space on one partition by up-taking the unused space of an
adjacent partition of a hard disk (including partitions of Apple Boot Camp).

o NTFS hot resize upward to enlarge an NTFS partition (system, locked) without rebooting Windows and
interrupting its work.

e Convert a file system (FAT16/32, NTFS, Ext2/Ext3) without reformatting.

e Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

e Modify file system parameters (make active/inactive, hide/unhide, etc.).

e Install New OS Wizard to make a system ready to install a new operating system.

e Undelete Partitions Wizard to recover an accidentally deleted partition.

File System Optimization Facilities

o 27 defragmentation strategies available to defragment FAT and NTFS file systems.

e MFT defragmentation and shrinking to improve performance of NTFS.

o Safe Defragmentation Mode to guarantee data loss free defragmentation of any version of NTFS and FAT.

o Low free space defragmentation (less than 1% of the free space required) to successfully defragment almost full
disks.
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Auxiliary Facilities

File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access
to the necessary files and directories regardless of their security attributes.

Recovery Media Builder to create a bootable recovery media on a CD, DVD disc, or flash memory, which can

later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help
you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility
supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray
and can handle multi-session burning.

Network Configuration Wizard to establish a network connection on a bootable recovery media either to save a

backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup
from a network computer for recovery purposes.

Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or
a boot virus activity.

A Boot Corrector is only available for the bootable recovery environment.

Supported Technologies

Along with using innovative technologies from outside, Paragon has developed a number of its own original

technologies that make its products unique and attractive for customers:

Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

Paragon Hot Copy™ technology to copy locked partitions and hard disks under Windows NT+ family operating
systems providing both high operating efficiency as well as low hardware requirements.

Paragon Adaptive Restore™ technology to successfully migrate a Windows physical system to a different
hardware platform (P2P).

Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power
outages or an operating system failure.

Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and
interrupting its work.

Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size taking into
account only the amount of actual data of the image.

Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.
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Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use
a bootable media when modifying system partitions.

Paragon VIM™ (Virtual Image Management) technology that enables Paragon products work with virtual disks
as though they are physical hard disks.

Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility
without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale
businesses when dealing with many physical hard disks involving complex setup.

GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

Supported Virtual Machines

Microsoft Virtual PC
VMware Workstation
VMware Fusion

Oracle VirtualBox

Additionally for Connect VD and P2V Adjust OS only

MS Windows backups (.vhd images)

Additionally for Connect VD only

Parallels Workstation

XenServer (.vhd only)

Supported File Systems

Full read/write access to FAT16/FAT32 partitions.

Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also
supported.

Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions.

Limited read/write access to Apple HFS+ partitions.

A

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media

Support of both MBR and GPT hard disks (2.2TB+ disks included)
IDE, SCSI and SATA hard disks
SSD (Solid State Drive)
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e AFD (Advanced Format Drive)
e Non-512B sector size drives
e CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs
e FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks

e PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Distribution
Paragon Partition Manager is distributed in two ways:
e Boxed package from Paragon Software GmbH and resellers

e Downloadable package over the Internet at the company’s web-site

Distributive CD

The boxed package includes a distributive CD that is in fact a bootable recovery environment with auto-run of the
Windows installation, thus it can be used as a ready-made solution. But if you’re going to run the Windows components,
you need to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described in Online Distribution).

Online Distribution

Partition Manager purchased over the Internet will be in form of an MSI package. After installing the product you can
launch the Recovery Media Builder to prepare a recovery media.

Depending on your product and edition, you might need to additionally download an image
A of our WinPE recovery environment, which opens the option to prepare it on a CD/DVD/BD

or a flash card before installing our software.

Registration

Paragon Software GmbH provides a wide range of online services through its web-portal - www.paragon-
software.com/support/:

e Registration of new users;
e Registration of purchased products for registered users;

e Available around-the-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

e Downloadable free demo versions and open documentation for all users.
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A It is recommended to use Internet Explorer 5+ or any compatible browser.

To register as a new user
To register as a new user, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

2. Click Create of the Create a Paragon Account section;
3. Fill out a registration form;
4. Click Register.
The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access
password will be sent to this address as well.
To register a new product
If you are a registered user and would like to register Partition Manager, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;

In the Password field enter a password received after registration;

2

3

4. Click Signin;
5. If the user name and password are valid, you will get to your account;
6. Click Register new product of the Products section;

7

Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from
your reseller. Click Next;

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;
In the Password field enter a password received after registration;

Click Sign in;

If the user name and password are valid, you will get to your account;

Select My Downloads of the Products section to see what updates are available for you;

N o v ok w N e

Select the desired update and click Download.

Contacting Paragon Software GmbH

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH.
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Service Contact

Visit Paragon Software web site WWwWw.paragon-software.com

Registration & updates web-service WwWw.paragon-software.com/support

Knowledge Base & Technical Support kb.paragon-software.com

Pre-sale information sales@paragon-software.com

System Requirements
For the Windows installation package
e Operating systems:
- Windows 2000 (32 bit only)
- Windows XP (32 and 64 bit)

- Windows Vista (32 and 64 bit)
- Windows 7 (32 and 64 bit)

e Internet Explorer 5.0 or higher

e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)

e Hard disk drive with 250 MB of available space

e SVGA video adapter and monitor

e Keyboard

o Mouse

A During the installation additional free space (up to 1GB) will be required.

For the Linux bootable environment
e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 256 MB of RAM
e SVGA video adapter and monitor
e Keyboard
e Mouse
For the WinPE bootable environment
e Intel Pentium Ill CPU or its equivalent, with 1000 MHz processor clock speed

e Atleast 512 MB of RAM
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e SVGA video adapter and monitor
e Keyboard
e Mouse
Additional requirements
e Network card to send/retrieve data to/from a network computer
e Recordable CD/DVD drive to burn data to compact discs

e External USB hard drive to store data.

Installation
To install Paragon Partition Manager, please do the following:

1. Run Setup Application. Click on the *.MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

4. Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

5. Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon\Paragon Partition Manager. To select another folder, click the Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.
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9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

mode hotcore driver, thus the system reboot is required to complete the installation

f To accomplish online operation on locked partitions/hard disks the program uses a kernel
procedure.

First Start

To start Paragon Partition Manager under Windows, please click the Windows Start button and then select Programs >
Paragon Partition Manager™ > Paragon Partition Manager™.

The program provides wide opportunities in the field of hard disk structure modification, so
just to be on the safe side, please make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

@ Paragon Partition Manager 11 Professional | Py |
Paragon Partition Manager 11 |
- e - Craracon

Fro sional

@ Peritioning Partitioning
What would you like to do?
+ Copying and —

R ‘ Create Partition
Mlgratlon ) Createanewpmoonandseuzpmoemes
1.
t_—; Backup and Rescue # Delete Partition
3 L Delete exdsting partition and all data & contains
P Boot Management # Resize Partitions
" \ Move border of adiacent parttions of the same type both logical or both prmary) to

redistrbute space between them. Note: this wizard covers only basic resize scenanios,
ff resize operation cant be camed out wth Express Resize Wizard, please swich to

\ 243 Partition Manager main launcher, nght click on a parttion you would ke to resize
@ Partition Manager and select "Move/Resize Parttion™

# Merge Partitions
Support Contacts N Merge two adacent paritions with the same fle system and the same type (prmary to
primary or logical to logical)

# Log Saver
. Prepare operation log fies to send to Paragons support team
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To know more on how to handle the product’s interface and accomplish typical operations,
please consult the Windows Components chapter.

Building Recovery Media
Recovery Media Builder can help you accomplish the following operations:

e Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD,
or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk
for maintenance or recovery purposes (strongly recommended);

e Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;

e Prepare a bootable recovery environment from any ISO image, including our WinPE 3.0 image (strongly
recommended);

e Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, or flash memory.
Below you can find how to build our WinPE 3.0 based recovery environment on a thumb drive:

1. Plugin athumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.

2. Inthe Main Menu: select Tools > Recovery Media Builder...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Onthe Wizard's Welcome page, click the Next button.
4. Select the Flash Memory option.

@ Hash Memory
Select this option to create the recovery envionment on a flash memory media. Thus you will get al
recovery features avaiable in the program on a compact. reliable. and fast device frecommended)
CD/DVD
Select this option to create the recovery environment on 3 CD/DVD. Thus you will also get a bootable

CD or DVD with all recovery features avalable in the program (ndispensable in case your computer
does not support booting from USB drives)

5. Select the User specified CD/DVD image (.iso file) option, then browse for an ISO image of our WinPE 3.0
recovery environment or manually type in a full path to it. By selecting the Typical option you can build our
Linux/DOS recovery environment, which we highly recommend you to do as well.

Typical
Use the standard Recovery Media image suppled with the program
o User specified CD/DVD image (iso file)
Use CD/DVD image from specific location
E-/Downloads/Paragon/winpe20_BR10_Sute-eaam iso [ Browse
Copy from a CD/DVD
Choose a source CD/DVD dive
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You can get an ISO image of our WinPE 3.0 recovery environment through the company’s
web service.

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if
several).

Forailable drives:

Diviwe Sq:lpm'nd Formats
drive 4 (500 MB)

7. You will have to confirm the operation.

WARNING: As a result of this operation ALL DATA cn the flash memory media will be ERASED.
Click "OK" if you agree or "‘Cancel' if you do not.

1: 0K | Cancel

Booting from the Linux/DOS Recovery Media

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your
hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-
standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only
basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup
To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

4. Consult the help system by pressing ALT+F1 to know more on the subject.

Boot menu
The Boot menu contains the following commands:
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=+ Mormal Hode Hain recouvery
& Safe Mode enyironment

& Low-Graphics Safe Mode

& Floppy disk

& Hard disk 8 MBR

& Find 05es on your hard disks

e Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);

e Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it
fails to work properly;

e Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

e Floppy Disk. Reboot the computer from a system floppy disk;
o Hard Disk 0. Boot from the primary hard disk;

e Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating
system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience
caused by possible video artifacts. It is just a result of changing video modes and in no way
will affect the program functionality. If this is the case, please wait a bit and everything will
be OK.

Normal Mode

When the Normal mode is selected, the Linux launch menu appears:
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You can create, delete and format hard disk

Paragon Partition Manager™ partitions wsing Faragon Partition Manager™,
which will stan now. Upon the stan, please
Restore Wizard select the drive and one of its partitions or its

free space. Then actvale the Pantition’
_ _ pull-down menu and select one of the
File Transfer Wizard partitioning operations.

»oF£F

!

Boot Corrector

Metwork Configurator

Log Saver

View the mounted partitions
Stan the command line
Eject CO/DVD

Reboot the computer

Power off

. @B BoiSs6,

Partition Manager (enables to run wizards and dialogs, to specify program settings, to visualize the operating
environment and the hard disk configuration);

e Restore Wizard (allows restoring hard disks and partitions);

e File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

e Boot Corrector (helps to correct the Windows System Registry without Windows being loaded);

o Network Configurator (enables to establish a network connection under Linux);

If you are going to use network resources, first launch the Network Configuration Wizard to
establish a network connection.

e Log Saver (helps to collect and send the necessary log files to the Technical Support);

e View the mounted partitions (the list of all mounted partitions will be displayed);

DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have

: The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in
different drive letters from Windows.

e Eject CD/DVD;

e Command Line (allows experienced users to execute any operation);
e Reboot the computer;

e Power off the computer.

To move within the menu, please use the arrow keys of the computer keyboard.
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Safe Mode

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Normal mode except for the Network Configurator and Log Saver commands. Besides due to certain limitations of the
PTS DOS environment, there is no possibility to burn CD/DVD discs.

Low Graphics Safe Mode

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks

similar to the Safe mode but graphically simpler.

g Partition Manager 11 You can create, delete and

# Sinple Restore Hizard format hard disk partitions
HE File Transfer Hizard using this program, which
[E Boot Corrector will start now,

Upon the start, please
M Start the command line zelect the drive and one of
® Reboot the computer its partitions or its free

space. Then activate the
'Partition’ pull-down menu
and select one of the
partitioning operations.

Booting from the WinPE Recovery Media
The WiInPE recovery environment can be a real alternative to the Linux/DOS recovery environment. Providing nearly the

same level of functionality it offers an excellent hardware support and the same interface as the Windows version does.

Startup

To start working with the WinPE recovery environment, please take the following steps:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the
appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use

the program.
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License .

Press Page Up and Page Down to scroll the text

End User License Agreement g
between

PARAGON Software GmbH,
Heinrich-von-Stephan-Str. 5 ¢, 79100 Freiburg, Germany,

and

You, as end user

If you accept the terms of the agreement, click the check box below

W&wmmmmmm |

e [ peame |

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run

components of the product, load drivers for undefined hardware or establish a network connection.

\') Paragon Partition Manager™ 11 Professional 7 _ ‘_IIDJ}J
- - m P -
Paragon Partition Manager™ 11 P S(,
Partitioning Partitioning
What would you like to do?
Copying and 1l
_— ratign ‘ Create Partition |
9 Create a new partion and set &3 propedies *
gi Ty # Delete Partition
. Rescue L Delete existing pastition and i data & contains
PR Boot Management » Resize Partitions
. Move border of adjacent partiions of the same type both logical or both primary) to
redistrbute space between them. Note: this wizard covers only basic resize scenados,
ff resize operation cant be camed out with Express Resize Wizard, please swichto
” Tool Partition Manager main launcher, nght click on a pastition you would ke to resize
N S and sslect "Move/Resize Parttion”
#» Merge Partitions
@ Partition Manager L Merge two adjacent patitions with the same fle system and the same type (prmary to
primary or logical to logical)
0 Support Contacts
© Help B Restart [@) Shutdown

4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

5. Consult the help system by pressing ALT+F1 to know more on the subject.
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Our WinPE 3.0 based recovery environment offers excellent hardware support. However in
A case it doesn’t have a driver for your disk controller, your hard disks will be unavailable.

Please consult the Adding specific drivers scenario to know how to tackle this issue.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

System and Data Protection

The data protection issue is a growing cause of worrying for more and more people today. Indeed, it is hardly to find a
person who will be particularly happy when all precious information on the hard disk is irreversible lost as a result of its
malfunction. So how this tragedy can be prevented?

Backup Storage

Our program supports several techniques of storing backup images. Let’s take a closer look at them all to understand
what kind of storage is able to provide better security:

e You can place a backup image to a local partition. Despite the fact that it is the most convenient way, try not to
use it. You can delete your backup just by accident or lose it as a result of a hardware malfunction, or a virus
attack;

e You can place a backup image to an external mounted storage to provide for a higher level of data protection
and system independence;

e You can place a backup image to a special secured place on the hard disk called the Backup Capsule that has an
independent system layout (e.g. a separate partition) and will stay operable should the active file system be
damaged. To avoid an accidental removing or unauthorized access of the backup data, this partition is hidden
and thus cannot be mounted in the operating system. However it won’t help you in case of a hardware
malfunction;

e You can place a backup image to external media (CD/DVD) to guarantee a high level of data protection as long
as the backup media is kept secure;

e You can place a backup image to a network drive to stand a better chance of success in case of a hard disk
failure. Moreover, by storing it on a special-purpose server you may be pretty sure nothing will happen to it.

Adaptive Restore

Technology Background

Windows family operating systems are notorious for their excessive sensibility to hardware, especially when it turns to
replacement of such a crucial device as HDD controller or motherboard — actually Windows will most likely fail to boot
as a result of this operation.

In 2008 our company came with an exclusive technology called Paragon Adaptive Restore™. Initially aimed at restore of
Windows Vista or Server 2008 from a backup to a different hardware configuration, its current realization, available in
the P2P Adjust OS Wizard, enables to make any Windows OS since XP bootable on dissimilar hardware by allowing
automatic injection of all required drivers and the other actions crucial for this type of migration.
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Technology Concept

Let’s take a closer look at how Paragon Adaptive Restore works.

Devices

Source environment

k

Maodifying OS

Adi kernel
internal settings djusting kerne

Modifying additional
settings

eselting CP
parameters

ki

From the Windows
Repositony

Injecting drivers for
# boot critical devices
and NICs

From additional
driver repositornes

k.

Destination
Environment

As you see, successful migration of a Windows system to a different hardware platform involves several actions:

1.

Change of the Windows kernel settings according to the new configuration. The program detects the given
hardware profile and automatically installs the appropriate Windows HAL and kernel.

Installation of drivers for boot critical devices. The program detects those without drivers and automatically
tries to install lacking drivers from the built-in Windows repository. If there’s no driver in the repository, it
prompts the user to set a path to an additional driver repository, strongly recommending not to proceed until all
drivers for the found boot critical devices are installed. In case drivers for these devices are installed, but
disabled, they will be enabled.

Installation of drivers for a PS/2 mouse and keyboard. This action will only be accomplished for Windows
XP/Server 2003.

Installation of drivers for network cards. The program detects those without drivers and automatically tries to
install lacking drivers from the built-in Windows repository. If there’s no driver in the repository, it prompts the
user to set a path to an additional driver repository.

These actions guarantee a Windows system will start up on dissimilar hardware. After the startup, Windows will initiate
reconfiguration of all Plug'n'Play devices. It’s a standard procedure, so please don’t worry and prepare the latest drivers

at this step to get the most out of the system.

A

Though all Windows systems have built-in driver repositories, please be prepared to have
additional drivers when dealing with Windows XP/Server 2003, because for these systems
they are very modest.
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Technology Application
Let’s consider a number of situations when the Adaptive Restore technology can help you out:
e If you need to migrate to a different hardware platform with minimal effort
e If you need to upgrade hardware while keeping all programs and settings intact

e [f you need to replace failed hardware and cannot find an exact match for original system specifications

Known Issues

1. After transferring Microsoft Vista and later versions to different hardware, you will need to re-activate license of
the system. It's normal behavior as these systems keep tracking any change of hardware. Re-activation is legally
justified in this case, as you transfer your system to another PC.

2. If you've installed several operating systems on one partition, we can only add drivers to the latest version of
0S. Microsoft highly recommends that you install an operating system on a separate partition.

3. Please note drivers are not cached during selection. That’s why if you select a driver to add to the system, but
it’s already unavailable during the operation, the program will end the operation with an error.

System Virtualization

With new powerful x86 computers, system virtualization has become extremely popular. It’s a software technology that
enables to run several virtual machines on one physical machine, providing resources of that single computer are shared
across several environments. As a result one and the same physical computer can have multiple OSs and applications
operating simultaneously, thus opening up enormous opportunities for both, business and home users, exactly:

e Avoid underutilization of up-to-date powerful computers;

e Increase flexibility of a physical infrastructure;

e Provide for increased availability of hardware and applications;

e Cut expenses on hardware and energy;

e Guarantee smooth and cost saving system migration;

e Enjoy working with old applications you can’t launch on your current PC;

e Take advantage of having multiple operating systems on one Windows PC, including Linux, Mac OS X, etc.;
e Forget about hunting for replacement of the failed hardware, and many more...

Known Issues
1. You should install integration services (e.g. VMware Tools) on the virtual system yourself. We only guarantee its
smooth startup.

2. After transferring Microsoft Vista and later versions to a virtual disk, you will need to re-activate license of the
system. It’s normal behavior as these systems keep tracking any change of hardware. Re-activation is legally
justified in this case, as you transfer your system to another PC.

3. If your system hosts several Windows OSes, our program will find them all and automatically patch to runin a
virtual environment. However we cannot guarantee smooth startup of all found Windows systems, but the
guest OS, for its configuration parameters may be incompatible with the others.
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Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing

In the course of time there have been developed various methods of data processing. Despite different work concept,
all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating
system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating
efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production
environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is
particularly useful for systems with high availability requirements, but it won’t be accomplished until all active
transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process,
taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast
high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers
its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft
VSS framework.

Paragon Hot Processing Technology

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed
back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online
copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of
applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup
procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in
the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the
overall system performance, but a few kilobytes of the system memory.

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family
operating systems providing both high operating efficiency as well as low hardware requirements.

It is not recommended to use Paragon Hot Processing with active SQL Server, Exchange or
Oracle databases since the backup image contents may be corrupted.

Volume Shadow Copy Service

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-
time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading
copy/backup solution vendors on the market, it is based on a snapshot technology concept.

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as
virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility
starts processing the data while applications keep writing to original volumes.
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Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of
multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange
2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of
database performance and reliability, thus providing 100-percent data consistency.

A To use VSS it is necessary to have a mounted 300 MB+ NTFS partition.

Dynamic Disks

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four
primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create
logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows
2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four
primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also
introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage
hard disks.

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes.
Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly.
However, computers that aren't running Win2K can access the dynamic volumes remotely when connected to the
shared folders over the network.

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic
disks on the same hard drive.

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk
space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more
physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks, and RAID-5
volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks).

With dynamic storage, you can perform disk and volume management without the need to restart Windows.
Limitations:

e Dynamic disks are not supported on portable computers.
e Dynamic disks are not supported on Windows XP Home Edition-based computers.

e You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP
Professional, or Windows XP 64-Bit Edition-based computers.

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses
when dealing with many physical hard disks involving complex setup.

GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC
BIOS, it offers a number of crucial benefits:
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e Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
e The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
e More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;

o A well defined and fully self-identifying partition format (data critical to the platform operation is located in
partitions, but not in un-partitioned or hidden sectors as this is the case with MBR)

To tackle compatibility problems with older operating systems there has been introduced a special combined GPT+MBR
partitioning scheme called Retained GPT (also known as Hybrid GPT), where the first three partitions except for EFl (GPT
service partition) are synced between GPT and MBR. This synced partition map provides an avenue, for instance for
booting 32-bit Windows Vista/7 on computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and
Windows on a GPT disk.

Apple Boot Camp

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-
based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate
partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your
disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system
to start up.

It is strongly recommended not to modify the hard disk configuration with Windows Disk
Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and

A inability to boot in Windows XP/Vista. Please use our program to correctly update both
MBR and GPT.

64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Copy Operations

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system
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service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user
can get the system back on track in minutes. No additional configuration is required, what is very convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. One day the user realizes that there is no more free space
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk,
the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided
just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up
similar computers. There is no need for a system administrator to install an operating system from scratch on every one
of them. It is enough just to configure one and then clone it to the others.

Drive Partitioning

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up
and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the
entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity
hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD
images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
drives, but there is an easy solution — drive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-
fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue — in case of a system malfunction,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition of
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the
Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundaries of each OS.

Windows Components
In the given section you can find all the information necessary to successfully work with the Windows version of the

product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
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accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program

can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and

functionality:

Tools Changes Wizards Hard Disk Partition View

Basic Partitioning T

@ Create Pattion

Volume letter: (C)
Volume label: [No bbel]
Type: Primary
File system: NTFS
Root entries: 41546
Sectors per boot: 8
Sectors per cluster: §

Explorer Bar

s 399 G8 NTFS

Serial number: AE1EAE0A-184D-D21F
Partition ID: (07 NTES

Volume Size: 239G8
Partition size: 399GB
Used space: 94GB
Free space: 305GB
Activity: Yes

Hidden state: No

Local Disk (C?)

Volume letter: (C)
Volume label: [No labal]
Type: Pomary

o
Sectors (i

aueu-uu*oscsm*ou)
“ Local Disk (C) ’

2
. Used space: 54GB
Free space: 305GB
Activity: Yes
Hidden state: No
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B ONTFS W FATR M FATIE | LnxBa2 AT Lo Edd

|

1. Main Menu
2. Tool Bar

3. Virtual Operations Bar
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4. Common Tasks Bar

5. Explorer Bar
6. Disk Map

7. Partition List
8. Properties Bar

9. Legend Bar
10. Status Bar

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY

Tools

View Log Files View logs on the carried out operations

Send Log Files Compress and send the log to the Paragon Support Team

Setup Boot Manager... Manage several operating systems on one computer

Recovery Media Builder... Restore the system even when the current operating system cannot boot
anymore

File Transfer Wizard... Transfer data from any media

Settings... Edit the general settings of the program

Exit Exit the program

Changes

Undo “the last virtual Cancel the last virtual operation on the List of Pending Operations

operation’

Redo “the last virtual Cancel the last undo virtual operation on the List of Pending Operations

operation’

View Changes... Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations

Reload Disk Info Refresh the current information about disks

Wizards
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Express Create Partition...

Create an NTFS partition and make it ready for work

Create Partition...

Create a partition of any file system

Format Partition...

Format a partition of any file system

Delete Partition...

Delete a partition of any file system

Express Resize Partitions...

Increase free space on one partition by up-taking the unused space of an
adjacent partition

Undelete Partitions...

Recover an accidentally deleted partition

Merge Partitions...

Merge adjacent partitions of NTFS, FAT or FAT32 file systems

Redistribute Free Space...

Redistribute available disk space of existed partitions

Install New OS...

Make your system ready to install a new operating system

Back up Disk or Partition...

Create a sector-based archive of an entire hard disk or separate partitions

Restore... Restore an entire hard disk, separate partitions, or files from the backup image
P2P Adjust OS... Make your system bootable on different hardware

P2V Copy... Migrate a live Windows physical system to a virtual environment

P2V Restore... Migrate a Windows physical system backed up with a Paragon disaster

recovery tool to a virtual environment

P2V Adjust OS...

Make Windows Vista/7 backups bootable on virtual hardware; recover the
startup ability after unsuccessful virtualization with a 3" party tool

Copy Hard Disk...

Create a hard disk copy

Copy Partition...

Create a partition copy

Hard Disk

Convert to Basic...

Convert a dynamic MBR disk containing simple volume(s) into a basic MBR disk

Convert to Basic MBR hard
disk...

Convert a basic or a dynamic GPT disk containing simple volume(s) into a basic
MBR disk

Update MBR

Update MBR (Master Boot Record) of the selected hard disk

Change Primary Slots...

Modify the primary partitions enumeration for the selected hard disk

Edit/View Sectors...

View/edit sectors of the selected hard disk

Connect a Virtual Disk

Connect a virtual disk to work with it as if it’s a physical disk

Disconnect a Virtual Disk

Disconnect a virtual disk

Properties...

Get in-depth information on the properties of selected hard disk
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Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Move/Resize...

Move/Resize the selected partition

Convert File System...

Convert file system of the selected partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Hide Partition...

Make the selected partition unavailable for the operating system

Unhide Partition...

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition non-bootable by default

Change Volume Label...

Change volume label of the selected partition

Change Cluster Size...

Change cluster size of the selected partition

Change Serial Number...

Change serial number of the selected partition

Downgrade NTFS version...

Decrease version of the selected NTFS partition

Change Partition ID...

Change identifier of the selected partition

Change SID... Change SID (Security Identifier) value of any found Windows installation
Make Partition Primary... Make the selected partition Primary

Make Partition Logical...

Make the selected partition Logical

Defragment Partition...

Defragment data on the selected FAT or NTFS partition

Defragment MFT...

Defragment MFT (Master File Table) of the selected NTFS partition

Compact MFT...

Shrink MFT (Master File Table) of the selected NTFS partition

Test Surface...

Test surface of the selected partition/block of free space

Check File System Check the selected partition for possible file system errors
Integrity...
Edit/View Sectors... View/edit sectors of the selected partition

Properties...

Get in-depth information on the properties of selected partition

View
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Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar
Common Tasks Bar Display the Common Tasks Bar
Disk Map Legend Display the Disk Map legend

Properties and Commands Display the Explorer Bar

Disk Map Location Select whether the Disk Map will be located on the top of the main window or
at the bottom

Help
Help Open the Help system (you can also do it by pressing F1)
About Open the dialog with information about the program

Q The Main Menu contents available at the moment may vary depending on the selected
object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

@g Create an image of a hard disk or
partition

(e Increase free space on one partition
S by up-taking the unused space of an
adjacent partition

Copy a hard disk

Defragment the selected partition

@ Switch to Express launcher
it
(X

Open the Help system
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Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called
virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

i

fﬁ Cancel the last virtual operation on the List of Pending Operations
@a Cancel the last undo virtual operation on the List of Pending
Operations

Display the List of Pending Operations

’Qp Launch the real execution of virtual operations

% Cancel all virtual operations on the List of Pending Operations

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds

the user that there are unsaved changes by showing the following window:

A I There are unsaved changes.

Please use the & Apply command to comre the changeas and the % Discard
command to permanently undo the changes.

You can view the changes history via the . View Changes command and

ienmdiyu\dootredoﬂwooetotmbymmd&w“) Undo and ™ Redo
commands:

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's
wizards.

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it.

Basic Partitioning Tasks

@3 Bxpress Create Starting the Express Create Partition Wizard to create an NTFS partition and make
it ready for work.
@ Create Parttion Starting the Create Partition Wizard to create a partition of any file system.
@/4* Earmat Partition Starting the Format Partition Wizard to format an existing partition to one of the
y

file systems supported by the program.

% Delete: Partti Starting the Delete Partition Wizard to delete a partition of any file system.
EIEIE Farttion

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



37

Advanced Partitioning Tasks

&

"
k=k: Express Resize

Starting the Express Resize Partitions Wizard to redistribute free space between
two adjacent partitions.

=]
Ef_'ér Merge Partitions

Starting the Merge Partitions Wizard to merge adjacent partitions of NTFS, FAT,
FAT32 file systems.

ﬁ Redistibute Free Space

Starting the Redistribute Free Space Wizard to redistribute available disk space of
existing partitions.

[
@ Undelete Partitions

Starting the Undelete Partitions Wizard to recover accidentally deleted partitions.

Copying Tasks

[a_-r | Copy Disk

Starting the Copy Hard Disk Wizard to copy a hard disk.

£
(=2 Copy Partition

Starting the Copy Partition Wizard to copy a partition.

Backup Tasks

ﬂ-'; Back up Disk or Partition

Starting the Sector Backup Wizard to create an archive of a hard disk or separate
partitions.

e,
[,a':t- Restare

Starting the Restore Wizard to restore a hard disk, separate partition, or files from
the backup image.

Virtualization Tasks

[E, P2V Copy

Starting the P2V Copy Wizard to migrate a Windows system to a virtual
environment by converting all installed software and data into a virtual machine.

e,
[,,a':t- P2V Restore

Starting the P2V Restore Wizard to restore a Windows physical system from a
backup directly to a virtual environment.

@ P2V Adjust 05

Starting the P2V Adjust OS Wizard to restore functionality of a virtual
environment after unsuccessful virtualization with 3-rd party tools; prepare
virtual machines out of supported virtual disks or Windows .vhd backup images.

Tools

- File Transfer Wizard

Starting the File Transfer Wizard to transfer data from any media. Besides it
provides access to Paragon backups as regular folders to browse through their
contents or copy required files.

@il Eoot Manager Wizard

Starting the Boot Manager Setup Wizard to easily manage several operating
systems on one computer.

=
W™ Install new 05 wizard

Starting the Install New OS Wizard to install a new operating system.
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Help and Documentation

) Launching the help system (you can also do it by pressing F1).
@ Partition Manager™ Help

fﬂﬁ ) Opening the page which contains information about the program. This page will
\4 About Partition Manager™ . .
be displayed in the Explorer Bar.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map
Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the
file system of the appropriate partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev) 3

Local Disk (C:)
4339 GB NTFS
Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.
Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Totalsize,
e File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

«  Limear
Limear Scaling Min Width
Loganithmic Scaling
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Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

The help system

e General information on the product including its name, version and a list of helpful links

Detailed information about disks selected on the Disk Map

Volume Explorer utility

Disk Editor utility
According to these categories the Explorer Bar has several tabs:
e Disk View, which offers the user the following options:
- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions
- Disk Editor to view/edit sectors of the selected partition/hard disk

- Volume Explorer to browse and export contents of the selected partition/hard disk

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form

e You can switch between these components by clicking tabs on the left side of the Explorer
Bar.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

"t;!'-" Return to the previously browsed
page

Gy Open the next browsed page

(> p pag

) Stop loading the current page
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Refresh the contents of the current
page

Partition List

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the
possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
- File system type,

- Size,

- Amount of used and unused (free) space,
- Start/End cylinder,

- Start/End head,

- Start/End sector

- Free size in sectors/bytes

- Active/Inactive attribute

- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

%) Pleaze select properties to display.
Please select properties you would ke 1o display in the Disks and Partitions view

Hame
Size (sactors

F35 Size (sacton

Usad [sactors)

O [ | [ ) ] | |

T =] [TV L [1i)
R

[ ]

|-
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By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change
its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:

Sart fsectors) | End [sactons) | Stad CHSheot) | Envd CHShex)

B0 ISFETFh 020 21
ASFER00h JETFEFFFh 3040 &1 15

800h  3IETFEFFR: 02021 FEFE 94 1E

Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:
For a hard disk

e Model,

e Serial number,

e Type of hard disk (basic or dynamic),

e Total size (in GB),

e Information on geometry of the disk (amount of sectors per track, heads and cylinders).
For a partition

e Drive letter assigned to the disk,

e Volume label (if available),

e Type of the logical disk,

e File system (represented by the color of the graph and the selected bar),

e Total size, used space and free space (in GB or MB).

Besides you can modify practically any partition property by clicking on the required value.

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32
- NTFS
- Linux Ext2/3/4
- Linux ReiserFS

- Apple HFS

Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.
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Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

Q To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.

General Options

{\g General options

Partition Abgrment Mode

Wista El
Align partitions according to the nies usad in Windows Vista and later 05es.

Check: F5 integrity policy

Oz :!

Standand protection from data loss with acceptable paformance. The file system
inbegrity will be checked for each volume only once just before accomplshing
data-senstive operations

Deta Loss Protecton mods
Mediam protection from data loss

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

e Enable Initial Backup reminders. If this option is marked, the program will automatically offer to make a backup
before accomplishing any critical partitioning operation, thus minimizing the risk of data loss.

e Partition Alignment mode. There are three options you can choose from:

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder”
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When
partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters,
thus resulting in a double read-write operation.

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole
disk drive. It is optimal for both, 512B and new 4K disk drivers.

- Inheritance. Select the option to disable automatic alignment of partitions.

e Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute,
change cluster size, etc.) is potential with data loss. To minimize this risk, it's recommended to check integrity of
your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you
several options to let you choose, which is best for you:

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time
it’s necessary to guarantee the maximum protection for the on-disk data.
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- Once. Standard protection with acceptable performance. The file system integrity will be checked for each
volume only once just before accomplishing data-sensitive operations.

- Never. No protection, but maximum performance. If you're not 100% sure your disk is rock solid, please do
not use this option.

e Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been
abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

- Do not protect. No protection, but maximum performance. If you're not 100% sure you’re completely safe
from a power outage, or an accidental reset of your computer, please do not use this option.

- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program
enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your
computer from our bootable recovery media, thus reviving the corrupted partition.

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also
disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a
power outage.

Backup Image Options

E’,@' Backup image oplions

| Control archive inegrty

Choose this option to allow witing of specific data that will later be used duing
resions to check the anchive integrty. |t can sow down the backup opsration

/| Set image fie names sulomaticaly
Chooss this opbion to autcmatically name files in complex archive.

Compression level
MNomal compression :|
Good compression. Provides average speed with the reasonable image size

Image spit

| Ensble mage spliting
Chooss this option to anable spliting the archive to several fles

Masimm splt sire: | 4000 MB

This section contains a set of options that will be taken into account during backup/restore operations:

e Control archive integrity. Mark the checkbox to guarantee that all backup images created with the program are
100 percent flawless. If you decided not to control the archive integrity, the backup operation would take about
3-5% less time.

o Set image file names automatically. Mark the checkbox to make the program automatically set a file name for
every volume of a complex backup image. Otherwise you will need to do it manually during the backup
operation.

e Compression level. From the pull-down list you can select the desired compression level for backup images that
will be used by default.

e Enable image splitting. Mark the checkbox to automatically split every backup image to volumes of a particular
size.
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A

Splitting images enables to tackle problems caused by a maximum file size limitation of
some file systems.

Maximum split size. With the spinner control you can specify a maximum size for backup volumes.

General Copy and Backup Options

% General copy and backup options

Hdd raw processing
Copy an entre hard disk sector by sector without taking into account &s partition structure

Parttion raw processing

Copy/Backup each parition sector by sector. All sectors will be processed one by one {even
unused sectors). Requires more time to complete the operation.

Pedom incremental copy

This option is intended for copying only changes on the hard disk since a previous copy
operation. The program performs comparison between a previous copy of the hard disk and
its cument state. Only sectors that are diferent will be wrtten to a new copy

V! Skip OS awdiary fles
Choosa this option to skip OS awdiary files (ke pagefile sys, hberfi sys etc.), This wil reduce
operation time and backup image size

This section contains a set of options that will be taken into account during copy and backup operations:

HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus
ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be
processed as well). This can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accomplish the operation.

Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems as it takes more time to accomplish the operation.

Perform incremental copy. Mark the checkbox to only copy changes on the hard disk from the moment of the
last copy operation. The program will perform comparison between a previous copy of the hard disk and its
current state. Only sectors that are different will be updated, thus considerably decreasing the amount of data
to write.

Skip OS auxiliary files. Mark the checkbox to skip OS aukxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.
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CD/DVD/BD Recording Options

Bum every CD/DVD/BD disk to the end

Choose this option allow the disk to be copied by third party tools
Recording speed

Select speed automatically ;}
Auto recording speed. Choose this option to allow the recorder to choose the best
speed
Boot options
Spacfy a bootable ISO image to place on CD, DVD or BD along with backup data

\.\ISO'bootcd iso Browse I

Specfy how would you like to boot from CD, DVD or BD

Boot from any CD. DVD or BD (]

IS0 image folder

Browse

Please selact a folder to place 1SO images to when CD, DVD or BD I1SO maker is

used

This section contains a set of options that will be taken into account during CD/DVD/BD burn operations:

Burn every CD/DVD/BD to the end. By default, the program does not create 1ISO 9660 compliant burning
sessions, as it processes data on-the-fly and can only estimate the resulted session size. That’s why no third
party tool will get access to the recorded data. To tackle the issue, mark the checkbox to make the program
create a standard Disk-at-Once session. It may slow down the burning process, as every CD/DVD/BD will be
recorded up to the end, no matter how much actual information to contain.

Recording speed. The user may define how fast a CD/DVD/BD will be recorded (minimum, normal and
maximum). Besides there is an automatic mode when the program will set the most appropriate speed for
every CD/DVD/BD.

Bootable ISO image. That’s the image to be placed together with the backup data. By default, the program
offers its own bootable ISO image, which contains a Linux/DOS recovery environment. However, the user is free
to use any bootable ISO image.

CD/DVD/BD boot capability. The program enables to choose whether any recorded CD/DVD/BD will be
bootable, or only the first one for a session, or without that function at all.

Folder where the ISO image is to be placed. When the user decides not to physically burn a CD/DVD/BD, but
create an ISO image file, this very folder will be used to contain these images.
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Hot Processing Options

7| Enable hot processing

Hot processing technology

Microsoft Volume Shadow Copy Service =
Microsoft Volume Shadow Copy Service is a relisble technology designed to back
up volumes being locked by numerous active transactions of VSS supporting
applications. Microsoft VSS technology requires over 300 MB of free space on
any mounted NTFS volume for temporary data. This technology is provided for
Windows XP and nawest Windows versions, but unavadable for old versions of
Windows (S8/ME/NT/2000)

Addtional options
Always use hot processing

@ Use hot processing only when partiion is locked
Hot procassing temporary dive

¢ 5]

Number of attempts to start VSS: 3

Timeout batween attempts fin seconds). 120 2

V| Switch between Hot Processing technologies

In this section you may configure the hot processing mode:

e Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially
designed to process data without restarting your operating system.

e Hot processing technology. From the pull-down list you can select the required hot processing technology.

e Always use hot processing. Select the option to process partitions without making them locked. Thus you will
be able to keep working with them as usual.

e Use hot processing only when partition is locked. Select the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

e Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot
backup data (by default — C:).

e Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a special boot-up mode.

e Timeout between attempts (in seconds). Here you can set a time period between different attempts to start
Microsoft VSS.

e Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot
Processing and Microsoft VSS if one of them is unavailable at the moment.

Partitioning Options

Enable 64 KB clusters for FAT16

Choase this option to enable 64 KB clusters for FAT 16 paritions. With this setting,
you will be able to create FAT 16 parttions with capacity up to 4 GB. Please note
that only Windows NT famiy systems will ba able to access such paritions

Confirmations
V| Ask for volume label before partition delete

Ask confimation when convesting FAT16to FAT32

This section contains a set of options that will be taken into account during partitioning operations:
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e Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

e Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

e Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.

E-Mail Options

Specify your e-mail account options:
Outgoing mal server [SMTF)
Uiser &-mad address

H’ﬁ'mmmmmh&tm

Specify e-mail notificalion oplions:
Send E-Mai notification on apply

Sedect the operations you would e to be notified about

This section contains a set of options that will be taken into account during the Send log files and Send e-mail
notification operations:

e Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to
a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the
SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a
traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. XXX.XXX.XXX.XX).

e User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or
organization's e-mail administrator.

e My outgoing server requires authentication. Activate the option to allow the program to make authentication
on the server before sending messages.

- User name. Enter the name that will be used to log in to the e-mail account.

- Password. Enter the password that will be used to access the mail server.
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e Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.

- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text.

- Send complete report after applying operations. Activate the option to create an in-depth report on the
carried out operations and send it after performing the last operation.

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the program
to attach two pictures of the disk layout made before and after the operation is completed.

By clicking the link at the bottom of the window you can jump to the Operation
Dependency Options.

Operation Dependency Options

@ Operation dependency oplions

Flease selact & task to be camed out when one or mone of the fallowing operstions are
commitbed.

Perom the task: | Sand e-mall notfication [ =]

Operation -
Adust 05 to boot on new hardware
Adpust 05 to boot on vitual hardwane
Backup partition or disk
Boot recond comection
Changs NTFS version
Change SID
Check file system
Compact SMFT
Connvert Dynames Disk: 1o Basic
Copy partition
Copy partition with fles eochusion =

] ] [ [ () ] | | [ [

Select all ][ Cloar all Fhumdufm

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function
is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-
mail notification on its completion or not.

A You won't be notified if an operation requires the system restart.

Virtual Mode Options

Operations mode

V| Allow virtual mode

Set this option on to cany out all the operations vitualy. You will be able to
commit the changes or rolback al of them or the last one. ¥ you switch this
option off, the operations will be camed out immediately

Close progress dialog automatically
Set this option on to automatically close the progress dialog after committing the
changes

In this section you may configure the virtual mode:
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o Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

e Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.

File System Conversion Options
QG . :
$ File system conversion options

Sedact a time zone
(GMT) Greenmwich Mean Time; Dublin, Ednburgh, London, Lisbon -

Selact language for file names
Engish (CP-850)

This language will be used to specfy national symbols in file names

1]
(<

Confirm settings before NTFS <~> FAT/FAT32 conversion
Choose this option to make the program to allow 10 customize these sattings each
tme when converting file systems

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By
default, the program takes locale (regional) settings from the system. Problems might occur however because of
different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file
systems.

To tackle problems of that kind you can manually set:

e Time zone to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time)
while FAT uses a fixed local date and time. The program takes proper account of these differences and enables
to adjust timestamp values.

A An incorrectly chosen time zone might lead to inability to launch certain software.

e Language for file names to use during the convert operation. NTFS stores file names in Unicode while
FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is
required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

An incorrectly chosen codepage will certainly result in corruption of non-English file
‘ : s names.

e Request confirmation of settings before NTFS < - > FAT/FAT32 conversion. Mark the checkbox to automatically
display the local settings dialog to check and modify (if necessary) the default parameters before launching the
convert file system operation.
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Defragmentation Options

Defragmentation mode
Safe mode [recommendad) [=]

Slow but reliable. In this mode the program requires free space on the defragmented
ot the moment partition o guarantes protection of your data in case of a power
cutage, hardwane mafunction or a system faiure.

In this section you may set the preferable defragmentation mode:

e Fast mode. Partitions will be defragmented rather fast (a 10-30% gain depending on the fragmentation level),
but a power outage, hardware malfunction or a system failure during the operation might lead to the data loss.

o Safe mode. To guarantee protection of your data during the operation, the program will allocate some free
space (not less than the on-disk largest file) on the defragmented at the moment partition to make a duplicate
of every processed file. Thus we strongly recommend you to use this very mode.

Log Files Options

“og Log files options

Choose a storage e span for the stubact log file. Please note, once the defined pediod

hias bean eqired, the fils will be smptied.
@ Ifinle

Marurnal
Custom

In this section you can specify a storage life span for the stubact.log file:
¢ Infinite not to empty the file ever;
e Minimal to have the file emptied all the time;

e Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the
file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having
A problems with the program, our Support Team won’t be able to study operation logs, thus
help you out.

Viewing Disk Properties

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.
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-

| Basic Hard Disk 1 (FUJITSU MPF3102AT)

‘ Type: Basic Hard Dick Drive
| Total size: 35GB
: Sectors per track: 63
Heads: 255
Cylinders: 1245

' Create an image of the e disk
Back up 3l the data this haed disk containg, All the paititions on this disk will be added to the archive.

Restore an image of the entire disk
Warning: This operation wil delete all the data on this haid disk. All the pattitions will be replaced with cnes from
the mage you have chosen. You may aleo be asked to restaet your computer during thes operation

(
re |

Copy the entire hard disk
Create a copy of the entire haed disk
Al the pastitions on this disk will be copiad on the specified targat disk.

£ &

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
o Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

' Logical Disk (G)

Volume letter: [G:) Seral number: 7493E48F
Volume label: FAT32-LINLX Partition ID: 008 FAT32
Type: Primary Total size: 68GB
File system;: FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Activity: Inaclive

Hidden state: Not hidden

A Create an & e of the logical disk
g Back up all the data this logical disk conlains.
; Restore the logical disk from an image
g Warning: This operation will delete all the data on this logical disk and replace them from the image you have
¥ chosen. You may also be asked to restart your computer during this operation.
‘i\;,;?

Copy the selected partition
Create a copy of the paitition. A new pastiion will be created and all the data wil be copied there.
‘You can create an exact copy, of copy only the area that is occupied by data.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:

e Volume label (if available),

e Type of the logical disk,
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e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).
Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.
Viewing Image Properties

General information on backup archives can be obtained with the following tools:

Using the Restore Wizard

e |nthe Main menu: select Wizards > Restore...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

At first, the wizard displays the Welcome page — simply click the Next button at the foot of the dialog window.

The next page refers to Browse for Archive. By clicking the Switch to Archive List View link, you can see a list of images
contained in the Archive Database (if any).

(8 Restore Wizard (-0 el

Browse for Archive

Flaase sebact an archive to nestons. i
Boovd [ & B b
Type Creation Date Source Object Size [
[] /272009 2.21.01 AM  Basic Hard Disk 1 (VMware, WMware Vidual 5 SCS| Desk Dev) 0GB
F b
avitch bo Hle Ve

Archive Fie Detais

Hame: Basic Hard Disk 1 (Unknown Model)
Commerd; My hdd2

Type Irtemal Hard Disk Dive

Total size: 10GE

Fle C/'anc_neve/arc_new.PEF

To continue, cick MNext

<Back || MNet> | [ Conce

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e. Archive File
Details) display a short description, including:

e Information on a type of the archive contents (whether it is sector-based or file-based),
e Whether the archive is compressed or not,

e Whether the archive is password protected or not,
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e The date, when the archive was created.

In addition, there are some special graphical flags to indicate crucial properties:

FLAG FUNCTIONALITY

E Disk archive

= Partition archive
d File archive

g | MBR archive

)4 System archive

(5 Encrypted archive

Compressed archive

Complex archive

Differential archive

=
&
b Filtered archive
i
i

Incremental archive

e File increment to a partition
archive

To easily manage images in the Archive Database, the program provides the following functionality:

BUTTON FUNCTIONALITY

& Refresh the contents of the database

53 Show only existing archives

&9 Add the selected archive to the database

% Delete the selected archive from the
database

Besides you may filter backup archives to decide whether to show only file, partition or hard disk archives. To do that,
please select the required filter in the left top corner of the page.
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Browsze for Archive
Fleaze select an achive lo iesione.

& Show v @ e

*  Souice Obect

“al Show disks ¥
2 Show parlitions E0%10  Master Book Reco
“| Shiows file ancheves  |B0BL3S Master Boot Reco

20.05.2008 16:06:43 Fil-lavel uchive
J 20052008 160548 Fie-bavel Archive
= 14122007 200219 Master Boot Reca

By clicking the Switch to File View link, you can find the required image in the browser-like window.

('S Restore Wizard [ |l
Browse for Archive : 1
Plaase sedact an archive to restons.
Lookin: |[5] Local Disk [T} x| & ® 2
Name [Sze | Date ITa]
= [5] Local Disk (C)
=, anc_new 2008 22121 AM
arc_new PEF SEKE 9/2/2009 221:28 AM
Fles of type: | Avchive fles =]
Switch to Archive List Wiew

Archive File Details

NHame: Basic Hard Disk 1 (Unknown Model)
Commend; My hdd2

Type: Irtemal Hand Disk Dfve

Total size: 10GE

Fle C:/are_peve/are_new PBF

To continus, clck Next

[<Boa [ het>_] [ Conca

The section below (i.e. Archive File Details) displays a short description of the selected image, including:
e Information on a type of the archive contents (whether it is sector-based or file-based),
e Whether the archive is compressed or not,
e Whether the archive is password protected or not,
e The date, when the archive was created.

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map network
drives by clicking the appropriate buttons.

The next page (i.e. What to restore) displays detailed information about the contents of the archive.
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("% Restore Wizard R ="
What to restors
Flaase select an archive tem to restors .
Flaase selact one of the object (=) 1o restome:
Hame Tipe Fle system | Size Lised
:_iBaﬂcHnrstk1LU'krﬂ'mHod-dj Irtemal Hard Disk Drive 10GE
5 Local Disk (7 Primary Liniee Swap2 5098 MB 4KB
o &= Local Disk (7 Primary Linue B3 14GE 58.1MB
# |55 New Volume (F:) Frimary NTFS 24GB 3561 MB
&[5 NEW VOLUME [E) Primary FAT3Z 14GE 4HE
HArchive Details
Hame: Local Disk (%)
Vikume label: [No lakel]
Fie system:  Linux Bd43 Total size: 1.4 GH
Used space: 581 ME Free space: 1.3GB
To sedect whene to restors the selected objectis), click Nead Data size to restore: 1.4 GB
<Back |[ MNet> | [ Concel

If you want to restore the image contents, click the Next button. In order to cancel, click the Cancel button.

Data Backup and Rescue

In this chapter you will find all the information necessary to establish a reliable data protection system.

Creating Backup Images

Depending on a type of information you need to protect and the way this information should be processed, the program
offers a number of handy backup wizards. To make your job with the program as easy and convenient as possible, all
backup wizards share similar work algorithm. By going through steps of the wizard, you configure all the necessary
settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

Backup Wizard Startup
e Inthe Main Menu: select Wizards > Back up a Disk or Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Backup Wizard Setup
The wizard offers the following steps to accomplish the backup operation:

e The object to back up. You can back up either an entire disk or separate partitions of the disk (primary,
extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image
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such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful
for serious disk recovery procedures.

Name Type .ﬁu
= G My Computer My Comprter
= [l [7] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
= [l 75 First Hard Disk Track

=1 First Track
E2] = Master Boot Record MER 4
€ Local Disk (C) Primary N

(5] Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev) Intemal Hard Disk Drive
5% First Hard Disk Track First Track

(& Master Boot Record MER

e Backup destination. The wizard allows saving backup archives to local or network drives, to physical partitions

(without drive letters assigned), to FTP Severs, the Backup Capsule or burning them to CD/DVDs. You need to

select a destination, taking the estimated archive size and available space on the backup destination into
account.

There are saveral ways the Wizard can store your data, Please salect how would you ke to save the
archive

[Save data to the Backup Capsuie |
@ Save data to local/network drives

Save data to physical patitions

Save data to FTP locations

Bum the datato CD or DVD

Name and location of the resulted image. Provide a file name for the new image and its exact location. The

program automatically offers an easy to understand name containing the date and the time of the archive
creation, which can anyway be modified.

Select a folder whene archive should be placed and specify archive name. Archive name will be used as a
subfolder where backup data fles will be stored

Archive location:  Go/anc_test/

o K ¥

Name
= Gl My Computer

4 [Z] Local Desk (£

#1 [5] Local Disk (E)

¥ [5] Avchives (G7)

+ ﬂmmﬁ\m.ﬁ'l1m"#:'[zj
1 L] Natwork

Siza | Date

Archive detais
PArchive name are_fesi|
Estimated archive size: 2MB

Space available on backup destination: 38 GB

The program automatically calculates size of the future archive and informs the user about
space available on the selected destination.

o Archive Comment. You can add some additional description to the archive that will later help to distinguish it

from the others.
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Flease enter 3 shod comment to describe the anchive

[
Mo comment

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).

To activate the advance mode, you need to mark the appropriate option on the second page of the wizard. When it is

marked, the next page enables to define:

Whether the archive integrity will be controlled.

A

Checking archive integrity enables to guarantee that all backup images created with the
program are 100 percent flawless. Nevertheless if you decided not to control the archive
integrity, the backup operation would take about 3-5% less time.

Whether image file names will be set automatically in complex archives.
Compression level for the backup image (including the No compression variant).

Whether the archive will be split (if yes, you can set the maximum size for the archive files).

A

Splitting images enables to tackle issues caused by a file size limitation of some file
systems.

Whether the archive will be protected by password.

Whether the selected disk (or the selected partition) will be copied in the sector-to-sector mode (including
unused sectors as well).

Whether the OS auxiliary files (pagefile.sys, hyberfil.sys) will be included in the backup image.

Whether backup images stored in the Archive Database will be processed during the backup operation.

A

Skipping backups of the Archive Database may considerably decrease the resulted image
file and time to carry out the operation.

Recording speed when the user wants to burn the backup image onto CD/DVDs.
ISO image folder where the archive that is to be recorded on a disc, is placed.

Whether the operation will be performed without rebooting the system. The program needs to reboot the
system in order to have exclusive access to processing data. In a Windows environment this is difficult to
achieve because even when all the other applications are closed, the system service programs are still running.
However, there is a way to avoid rebooting. The mode of processing the backup operation without rebooting is
named Hot Processing. You can also define specific parameters for the Hot Processing mode.
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Result

After the backup operation is completed you receive an image of the selected object. This image is placed into the
specified destination, its features defined by the wizard.

Available operation scenarios:

e Backing up a hard disk or partition to external media (CD/DVD)

e Backing up a hard disk or partition to a network drive

e Backing up a dual boot Mac to an external USB drive

Restoring System and Data

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images
created with the program. It provides easy to understand instructions to configure and perform all the necessary
settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the
hint button and then the object you need.

Startup

e |nthe Main Menu: select Wizards > Restore...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the restore operation:
e A backup image to be restored. The Browse for Archive page enables to find a backup image you need.

By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive Database (if
any).

| Show all E| T E

Type Creation Dafte Source Object Size
97272009 50603 AM  Filedevel Archive 4 KB
e 9/2/2009 23300 AM  Local Disk IC) 439.5GB
9272008 22101 AM  Basic Hard Disk: 1 (Viware, Wihware Vitual S SCS1 Disk Dav) 10GB
‘ »
owitch to File View
Archive File Detals
Commeri, My documents
Backup date: 5/2/°2009 5:06:03 AM Total size: 4 KB (4,096 Bytes)
Archive size: 445 Byles
Fila G/ arc_doc/FLOODO00000000000000, archive pfi
Base archive

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e.
Archive File Details) display a short description.
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A To know more on the subject, please consult the Viewing Image Properties chapter.

By clicking the Switch to File View link, you can find the required image in the browser-like window. The section
below (i.e. Archive File Details) will also display a short description of the selected image.

Lookin: | [5] Local Disk (C) -] @ % 2
Narme | 5ze | Date -
3 [5] Local Disk IC2) £
= |, arc_new 97272009 2:26:04 AM
arc_new PBF SEKE 9272009 2.21:28 AM
#- || archive_db 8272009 5:35:22 PM
#- |, Pesflogs TAR2009 TITOS PN o
Files of type: | Archive files [=]
Swilch to Archive Lig View
Archive File Detais
Hame Basic Hard Disk 1 (Unknown Model)
Comment: My hdd2
Type:  Intemal Hard Disk Drive
Total size: 10 GB
e C-farc_new/arc_new PEF

Moreover, on this page you’ve got the possibility to create new folders, delete existing files/folders or map
network drives by clicking the appropriate buttons.

A To know more on the subject, please consult the Viewing Image Properties chapter.

File Backup Restore

e Data to restore. You’'ve got the option to restore not only the entire archive, but separate items of it (the so
called selective restore functionality) by marking checkboxes next to the data items you need.

Cick the check box next to any file or folder you want to restore from

Name Type Size

=}, FB Archive File Level Archive  113.1 KB (115,869 Bytes)
= R =/
4 | E1C
= |l £ Users
W 5 user
Wl (57 Desktop
CiSese |

v databackupandrescu... Fie 33KB
v databackupandrescu... Fie 135KB
restoresystemanddata,., File 239KB
restoresystemanddata... Fie HUEKB
To continue, cick Next Data size to restore: 46.5 KB
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e A place to restore. From the pull-down list you can choose whether to restore contents of the backup image to

its original location or specify some other one.

Restore files to
The files and f place where they were archived from
When restonng fieS TS SIEsay SR TN your computer
9 Leave existing files
Replace existing files

Besides if you select the Original location option, you can additionally define whether to replace already existing
files during the restore operation (good for recovering presumably corrupted files) or leave them intact (good
for recovering accidentally deleted files).

Sector Backup Restore

e Data to restore. You’ve got the option to restore not only the entire archive, but separate items of it (the so
called selective restore functionality) by marking checkboxes next to the data items you need.

Please select one of the object(s) to restore

Name Type Fie system | Size Used
2 [5] Basic Hard Disk 1 (Unknown Model)  Intemal Hard Disk Drive 10GB
& Local Disk () Prmary Linx Swap2 509.8 MB 4 KB
¥ L= Local Disk () Prmary Linux B3 14GB 58.1MB
2 (@ New Volume (F) Prmary NTFS 24GB 356.3MB
- . 'J.'
iCl s inoges |
5 | | System Volume Infoem
7 [ NEW VOLUME (E) Prmary FAT32 34GB 4KB
Archive Detais
Name: New Volume (F:)
Volume label: New Volume
He system: NTFS Total size: 24GB
Used space: 3563 MB Free space: 2GB
To salect whare to restore the selected objact(s), chick Next Data size to restore: 132.8 KB

If you select separate files or folders to restore, the wizard will continue working as though
you’ve got to do with a file backup.

e A place to restore. Selecting the destination, please note - all contents on the disk selected for restoring
purposes will be deleted during the operation.

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
. @) Local Disk (C:)
493.9GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

Ve EETE
IgLoch(E:) ©) Local Disk... Q) - I lg(uxauoc,
34GB FATR 24GBNTFS 14G..

220G
L2350

To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk
layout.

Restoring Partition:
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e Size of the restored volume and free space before and after it on the disk.

Geometry Restore Options
Please specfy the size of the rastored parttion 2470 | 36MB-2470MB
Please specfy size of free space before the parttion: 0 * OMB-2434 MB
Please specfy size of free space after the parttion 0 * OMB-2434 MB

e Drive letter assignment after restore. The pull-down list contains vacant drive letters that can be associated
with the restored partition.

Partition Restors Options
Aasign tha following drive letter: | F £

Restoring Hard Disk:

e Copy data and resize partitions proportionally. If this option is activated, the program proportionally changes

the size of partitions keeping their relative order intact. The option can be useful when restoring to a larger hard
disk.

o Perform surface test. Define whether the surface test will be accomplished during the operation or not.

Your hard disk after the changes

Basic Hard Disk 1 (VMware. VMware Vidual S SCSI Disk Dey)

E ol Disk () . ©) Local Disk ) I I ©) (Unalloc
34GBFAT3Z ZAGBNTES 146G 22G8

Ele |

Hard Disk Restore Options
Copy data and resize paritions proportionally

In this mode, the Wizard changes the size of partitions in the same proportion, with keeping intact their
relative order. This option can be useful in restring an image of hard disk to a larger one.

Pedform suface test

Set this option f you want the Wizard to pesform the surface test on the target hard disk. In this case, £ the
program finds bad and unreliable sactors & will mark them as unusable ones

All contents on the disk selected for restoring purposes will be deleted during the
operation.

Result

The wizard will restore the archived data, and make it available to use in the operating system.

To make Windows bootable on different hardware, please additionally complete the P2P
Adjust OS Wizard.

Available operation scenarios:

e Restoring a system partition from external media (CD/DVD)

e Restoring a system partition from a network drive

e Restoring a system partition from a local drive

e Restoring a dual boot Mac from an external USB drive

e Restoring separate files and folders from a backup

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



62

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition.

Cloning Hard Disks

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be
substituted by simply copying all on-disk partitions.

Copy Hard Disk Wizard

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup

e Inthe Main Menu: select Wizards > Copy Hard Disk...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the copy hard disk operation:

o The hard disk to copy. Select a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

@) Local Disk (C)

33 GENIFS

| Basic Hard Disk 1 (VMware, VMware Wuﬁis SCS! Disk Dev)

U @) Local Disk (E) l ©) LoBasic Hard Disk 1 (VMware, VMware Virtual S SCSI D
34 GB FAT3Z 2AGBNTFS TAG, || [EN22GE

o The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to.

Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content will be deleted

Basic Hard Disk 0 (VMware . VMware Virtual S SCSI Disk Dev)

l 9) ALocaI Disk {C) [Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)l

BNT
)

e Copy parameters. The wizard enables to specify the following options:
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Choose copy options that sut best your task
Copy options:
HDD raw copy
Parttions raw copy
Perform incremental copy
Resize options:
Remove free blocks between parttions
V1| Copy data and resze parttions prooomonaty

N\ Mark the checkbox to peoportionally change the size of panttions while keeping ther
!\ 1 ) relative order intact

" Tip: This can be very convenient when migrating to a larger hard disk

Copy options

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or the system administrator. However, it will take
more time to accomplish the operation.

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process
unknown file systems. However it is not recommended to enable this option when working with supported file
systems as it takes more time to accomplish the operation.

- Perform incremental copy to only copy changes on the hard disk from the moment of the last copy operation.
The program will perform comparison between a previous copy of the hard disk and its current state. Only
sectors that are different will be updated, thus considerably decreasing the amount of data to write.

Resize options

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize partitions proportionally to make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger
one.

Verification options

This section allows you to define whether the Surface and/or the Writing verification tests will be accomplished
during the operation.

After the operation is completed, you receive a fully functional duplicate of the existing hard disk.

A

To make Windows bootable on different hardware, please additionally complete the P2P
Adjust OS Wizard.

Available operation scenarios:

Migrating system to a new HDD (up to 2.2TB in size)
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Cloning Partitions

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample
partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file
system metadata (location of files, security information, access quotas, etc.).

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup

e Inthe Main Menu: select Wizards > Copy Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the copy partition operation:
e The partition to copy. Select a partition you want to copy.
On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Virdual S SCS1 Disk Dey)

l ©) Local Disk (C:)
499 9GB NTFS

Basic Hard Disk 1 (WMware, VMware Virtual S SCS1 Disk Dey)

I @) Local Disk (E) l ©) Local Dis... Q) - I I ©) (Unallo
¥ 3468 FATR 24GenNTFs ||| 146, 22GE

o Destination disk. Select a hard disk with enough unallocated space to perform the operation.

The wizerd will create 3 copy of Local Disk (F:)from Basic Hard Disk 1 (Viware, VMware Virtual 5
SC51 Disk Dev)

The copy will be created on Basic Hard Disk 3 (VMware, VMware Virual 5 SCS1 Disk Dev)
Fleasa sslact where to create a copy:

Basic Hard Disk 3 (VMware, VMware Virdual 5 SC51 Disk Dev)

I &) (Unallocated)
19.9GB

The program enables to copy a partition to a block of free space, which is smaller than the
partition itself, taking into account only actual amount of data.

e Copy parameters. The wizard enables to specify the following options:
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Your hard disk after chamnges

Basic Hard Disk 3 (VMware, VMware Viduad 5 5051 Disk Dev)

I ) (Unallocated)

Where to place a copy
Please specify the size of the new partiion 1824 T 39 MB - 20473 MB

Please speciy size of free space before the pariion: S DMB - 20434 MB
Please speciy size of free space afterthe patition: 16843 & 0 MB - 20,426 MB.

- Partition size. Define the size (in Mb) of the copied partition.

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map.

Result

After the operation is completed you receive a fully functional duplicate of the existing partition.

To make Windows bootable on different hardware, please additionally complete the P2P
Adjust OS Wizard.

Boot Management

Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager
Setup Wizard. Among the key features of the wizard the following should be mentioned:

e Up to 16 operating systems on one PC;
e Secure adding/removing of the Boot Manager startup record to/from the MBR;
e Auto Boot option to automatically start up the previously chosen OS after a certain time period;
e Hiding of any primary partition except selected at the moment.
Startup

e |nthe Main menu: select Tools > Setup Boot Manager...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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The wizard offers the following steps to accomplish the operation:

Boot menu options. In this section you can switch between the following modes:

- Normal mode. Choose this mode to display the boot menu every time the computer starts up and define a
timeout on the expiry of which the program will automatically select the previously chosen item of the menu.

- Hidden mode. Choose this mode not to display the boot menu until pressing a hot key. For this mode you
should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will

be displayed.
Boot menu options
@ Nommal mode
V| Timeout for booting last used configuration 15 seconds
Hidden mode
Time to display the BootManager stadup message

Choose a hot key for startup BootManager

e Deactivating/Configuring the Boot Manager. These two options will only be available once the wizard has been

completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR
(Master Boot Record) or Configure to modify the previously set parameters of the startup process.

o Codtou'c

Choosa this option to anter Settings page. You will be able to configure BootManager appearances and Boot

Deactivate
Choose this option to deactivate BootManager. This will remove BootManager and restors boot procass to s

previous state

Result

After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of

the booting process and to be able to display the boot menu.
Available operation scenarios:

e Creating Dual Boot Systems

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new partition within a block of un-partitioned space.
Restrictions

1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free

space on an existing partition to a new partition.
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3. The program cannot create new partitions on Dynamic Disks.
Express Create Partition Wizard Startup

e Inthe Main menu: select Wizards > Express Create Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Create Partition Wizard Startup

e |nthe Main menu: select Wizards > Create Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a block of free space on the Disk Map;

2. Select in the Main Menu: Partition > Create Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only

need to choose a method you find the most suitable to create the partition (if several available), which actually differ in
the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting
this or that mode.

The result you wil get sfter applying the changes

Basic Hard Disk 0 (VMware, VMware Virtual S SCS| Disk Dev)

I @) Local Disk (C:) I @) data {Z:) l @) New V

Please select the method of new partition creation
Smart Mode (Usa 182.1 GBto craate a partition ) More nfo
o | Advanced Mode | (Usa 108 5 GBto create a padition ) More nfo

Q The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first
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page of the wizard.

Create Partition Wizard Setup
The wizard offers the following steps to accomplish the operation:
e Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for

the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between
other partitions.

Ot this page you can Saact MAM s BN INe pLBcE whnene |0 Cresle & new panton
Basic Hard Disk 0 (VMware, YMware Vidual 5 SC51 Disk Dev) -
I @) Local Disk (C:) I @) data ()

Basic Hard Dizk 1 (VMware, VMware Virftual 5 5C51 Disk Dav)

I @) Local Disk (7] L

=R NTF

Basic GPT Hard Disk 2 {(VMware, VMware Virtual 5 SC51 Disk Dev)

I h. I Y_JJ {Unallocated)

Th.: pnr'lltll:n il be created "u:n:] F -

Lisa the butbons 1o move the madosr or drag mardoss by mouse. A new padition will b

the markeris

&
o
3
o
&
[
i

—

By default, the program allows you to create a new partition only as the last primary or as
Q the last logical drive within the extended partition. However, by activating the advance
mode on the first page of the wizard you can remove this restriction that in its turn might
result in some boot problems.

e Partition size. There is no restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free
space blocks together into one united block and moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus
resizing it.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



69
Your hard disiz bafore the changes
Sy ————— ..&;..“iﬁie.ﬁﬁﬁus.ﬂ.l.[:‘i;k.l;'.ie;-r]. —
: I I @) (Unallocated)
Your hard disk: aftar the changes

Basic GPT Hard Disk 2 (WVMware, Viware Vidoal 5 5051 Disk Dev)
I I ) Local Disk (%)

MNew volumne - cument sioe is 5658 GB

If a partition to resize is locked and cannot be processed, the wizard makes the system
reboot to create the partition and then automatically boots the system again. (The
rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate

checkbox.

e Partition properties. On the next page of the wizard you can set a number of additional parameters:
Your hard disk: after the changes

Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5C51 Disk Dev)

I l W) New Volume (E:)

Wolume |abal: | New Volume

Azsign the folowing diva latter: | E Tl
- Partition type. From the pull-down list select a file system the newly created partition will be formatted to,

otherwise the partition will remain unformatted (so that it will not be ready to use).

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and
mark them unusable in the file system metadata.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes

button to confirm the operation.
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[ ]
Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.
Basic Hard Disk 3 (WMware, VMware Vifual 5 5C5] Disk Dev)
I I 1) New Volume (H:) I
19.9GE NTFS

Create new partion 23 Fremary parttion [

Plaasa spacify new partibon size 20473 - TMB-20473 MB

Please specty size of free space befors the parition: |0 * OMB - 20,465 MB

Please specify size of free space afterthe patition: 0 = OMB-20472 MB

Please select file system for new partition: | NTFS El

Flease anter new volume label: HNeaw Voluma

Flaasa spacify dive letter H 3

%) [More options | Yes J l ] |

o Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.

e Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.

o Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

e File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).

e Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

e Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:
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| Usa 05 built in format routine

Flaase selact number of sectars per cluster: | 8 [=]
Please select number of seclors per boot

Please sslact number of oot entnes

\Rﬂm d-dat.ls.
e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

e  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

.A Number of available options depends on the selected file system type.

Result
After the operation is completed you receive a fully functional partition.
Available operation scenarios:

e (Creating a new partition to detach operating system from the rest of data

Formatting Partitions
Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.
Supported File Systems
The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16

- FAT32

- HFS+

- NTFS

- Ext2

- Ext3

- Ext4

- Linux Swap v. 2
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Wizard Startup

e |nthe Main menu: select Wizards > Format Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Format Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to
format.

On this page, you can choose a volume you would like to format

Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Dey)

‘.wwasc(c) ‘ l@dala(Z)
262 9GB NTF GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Devy)

I @) Local Disk (*)
4333 GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Dev)

I I ©) (Unallocated)

.A As a result of this operation contents of the selected partition will be lost.

e Partition properties. On the next page of the wizard you can set the following partition parameters:

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



73
Your hard disk after the changas

Basic Hard Disk 0 (WMware, Viware Vifdual 5 SCS1 Disk Dev)

I &) Local Disk (C:) l ) data (Z)

Wolume labal: | Mew Valuma

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the
next page enables to define:

]| Use O buik in format routine |

Pisase salact sectorns e ClUSteT

—

i -

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

o The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

.A Number of available options depends on the selected file system type.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format
button to confirm the operation.
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BCE )

= 4’ Are you sure you want to format volume (F:)?

You are about 1o format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new file system [ﬂﬂ-»:]
Please enter new volume label: | New Volume

¥) More options l Fomat | | No

e File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.

o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.
In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

| Use OS5 built in format routine
Please sslect number of sectors per cluster; | 128 3
Plaasa salact mumber of sectors par boot :

Fleass sslect number of oot entries:

Restore defauls |

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

e  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

e The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

.A Number of available options depends on the selected file system type.

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.
Deleting Partitions
Wizard Startup

e |nthe Main menu: select Wizards > Delete Partition...
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There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Delete Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

e Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to
delete.

On this page. you can choose 3 volume you would ke to delete
Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Dey)

IltyLocalDak(C:) ‘ lq_),daa(z;)
-t | 217

2825 GBNTFS 'GB NTFS

Basic Hard Disk 1 (VMware, VMware Virfual S SCS1 Disk Dev)

l ©) Local Disk (7)
493.9GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Vitual S SCS1 Disk Dev)

I I @) (Unallocated)

‘ !  You are sbout to destroy a bootable partition!

A As a result of this operation contents of the selected partition will be lost.

=

o Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the
required operation from the pull-down list.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



76

Merge free blocks cpbions

Do mot manps fres blocks 1r|

Margs fras Blacks B [na and 5 the dsk

Merge fres blocks al the beginning of the: disk

Dialog Setup
Initially the program suggests you just to remove references to the selected partition from the Partition Table.
o

7. Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comactly

71[Do not ask volume label next time |

e Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

e Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.

Advanced Partitioning Operations

Here you can learn how to accomplish advanced partitioning operations.

Merging Partitions

The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions,
into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the
second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.
Startup

e Inthe Main menu: select Wizards > Merge Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e The partition to expand. Select a partition, the size of which you need to increase by up-taking contents of an
adjacent partition.
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On this page. you can choose 3 partition that will be expanded to include adiacent parition. Please note that & is
possbie to select only FAT, FAT32 or NTFS partitions. You will not be able to proceed futher # no adacent

parttions of these types are present on the GisK

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)
©) Local Disk (C:) . ©) data (Z))
W 222 3 GB NTFS 217GB NTFS

e The partition to merge with. Choose the second partition for the merge operation, the contents of which will be
placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder
name to store files of the second partition, which however can be customized.

Selact an agacent pattion 10 marge with the tangat pattion. This pantion wil be margad 1o the one you have
selectad on the previous page. The content of the second parttion will be placed in a folder inside the resulting

partition

O0r

Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Dev)

l @) Local Disk (C:) l ©) data (Z)

2829 GB NTF 217 GB NTFS

Specfy a folder name to keep content of the selected parttion

Foidar Nama |mergad_partttion_conrtent

Be particularly careful when selecting system partitions to process, since the incorrect
order, in which two partitions have been chosen, will result in inability to boot the

=

operating system.

Result

After the operation is completed the disk space of the two adjacent partitions will be consolidated.
Redistributing Unused Space between Partitions

Express Resize Partitions Wizard

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused
space of an adjacent partition of your hard disk.

Startup

e |nthe Main menu: select Wizards > Express Resize Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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Setup

The wizard offers the following steps to accomplish the operation:

e Adjacent partitions to resize. Click on the left partition of the pair of partitions you need to redistribute the
unused space between, as the right one will be selected automatically.

The wizard wil resze space between Local Disk (C:) and data (Z:) on Basic Hard Disk 0
(VMware, VMware Virtual S SCSI Disk Dev)

Select left parition from a par of adacent pantitions you would ke 1o rasize. Right adiacant parttion wil ba
selacted automaticaly

Basic Hard Disk 0 (VMware, VMware Virdual S SCSI Disk Dev)
. ©) Local Disk (C:) l Q) data (Z)

e Resulted size of partitions. Redistribute the unused space between the partitions with the slider or manually by
entering the required value.

Please specfy new sizes of selected padtions

Selected pant of Basic Hard Digk 0 (VMware, VMware Virtual S SCS| Disk Dey)

I @) Local Disk (C:) l @) data (Z:)

Left volume size Right volume size
28977¢MB % MB | 222221M8 & MB
Result

After the operation is completed the unused space between the specified partitions will be redistributed according to
your needs.

Available operation scenarios:

e Increasing size of a system partition by taking unused space of an adjacent logical partition

e Resizing partitions of Apple Boot Camp

Redistribute Free Space Wizard

The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated
space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of
the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate
positions of the partitions and move their contents to new locations.

Startup

e Inthe Main menu: select Wizards > Redistribute Free Space...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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Setup

The wizard offers the following steps to accomplish the operation:

e Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions.
Blocks of the free space (if any) will be automatically added to the target partition.
Chooss 3 volume to expand
Basic Hard Disk 0 (VMware, VMware Virtual S SCST Disk Dev)
l(_))loch(C:) lq_)}dda(Z:)
282.3GB NTFS 217 GB NTFS
(1) Capasty of the volume (C:)is 282.9 GB. The wizard can expand this volume up to 485.3 GB at the
expence of other volumas
How wil the wizand expand the voluma?
[ )

Partition to donate. Choose any partition(s) (not only adjacent) to donate free space.

Select volumes to take space from. Free space from that vokume will be used to enfarge the volume you have
salected on the previous page

:".’o'uere Fle system | Type | Capacty | Used space | Free space | U Free
@z NTFS Prmay  217GB 146GB  202.3GB 9% |

There is no unalocated space on the hard disk you have selected. The wizard can only expand the
volume (C:) at the expence of some other volumes. Please ciick the chack box nest to any volume to take
free space from

Partition size. By default, the program leaves 50% of the unused space on a partition and removes another 50%

to add it to the target partition. However, the size to take can be customized by moving the slider or by
manually entering the exact value.

Your diskc after the changas:

.B‘-aaic Hard Disk 0 (VMware, VMware Virtual 5 SCS1 Disk Dev)

I‘_ijn-cdD:ﬂc[C} B @) data ()
3841 GB NTFS 11EEEE'.T:5_
Salact new size:

353,371,585 ME | 283.776 ME - 436,575.28 ME

b Curent volume size: 384,17 GB
The volume size has been increased on 101.1 GB.
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Result
After the operation is completed free space of the specified partition will be increased by up-taking the on-disk
unallocated space and the unused space of other partitions.
Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes references to it in
the Partition Table, thus leaving the possibility to recover it later.

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other
partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup

e |nthe Main Menu: select Wizards > Undelete Partitions...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the undelete partition operation:

e Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks.

Chck: the check box next bo any hand disk dive or free block you wand to examine

Name Type
= Bl My Computer My Computer
¥ [5] Basic Hard Disk 3 (VMware, Vidhware Vitusl § SCS1 Disk Dev) Irtemal Hard Df

I —
Froo space

The summary sre of fragment (3) to analyze i 19.9 GB

e Search method. By default, the wizard selects the fastest search method for your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has been created with
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually
select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard
still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in
the specified search area to get the most accurate results.

Choose how to look for the deleted partitions:
| Quick search for partitions. created by Vista or later OS
@ Conventional search
Thorough search
¥ Show file systems search options
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To know more on the available search methods, please use the context sensitive hint
system.

o File system filter. By default, the wizard will search for all known file systems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
f-l known file systems
FAT and FAT32 file systems
V| NTFSfile system
Uinux B42 and Bxd3 file systems
0S5/2 HPFS file system
Other funkisted) file system
To begin search, cick Next

e A partition to undelete (if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.

E} Saarch delslad parttons from secter 40 10 saclor 27HF

The following partitions have been found:

File system Type .Capmh' Used Space [ % Used
T NTFS Primary 199GB 853 MB 0
[ Stop ssanch ]

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result

After the operation is completed you receive a fully functional partition.

Installing a New Operating System

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the
system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new
partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and
checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic
tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and
then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all
the necessary operations to install a new operating system.

Startup
e |n the Main menu: select Wizards > Install New OS...
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There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup

The wizard offers the following steps to accomplish the operation:

e Partition to install a new operating system. The program offers two ways of installing a new OS, i.e. to create a
new primary partition for it or use an existing one.

Wheie would you ke to mnstall an operating system?
(%) | want to create 3 new pamary parition to install 0S

A new paitiion will be created by using unallocated space of your hard disk or unused space of exasting
pashitions. It is the most preferable way as no system of user’s data will be affected duning the instalabon
process

() | want to use an existing pematy partition to instal 0S.
In case creahon of a new primary partiion is not possible there are already four primary partitions on the
disk) of not desirable, you are free to select any of existing pamaty patitions. Please note that all data on

the selected partition will be deleted ¥ you choose to format it latet in this wizard Besides make sure no
opetating system has alleady been mstalled on that partion

.A Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

A hard disk (if several) where a new partition will be created. Thanks to an advanced program engine it is
possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new
partition;

O thas page wou can choosa a hard disk [ sevveral] whene pou would e to create a new primany partition
|Basic Hard Digk 0 [Maxtor P 250P0)

W) ') N l @) |
|||I 132 3.GB HTFS 737

Tobal sipe; 1939 GB

+ 7.
Basic Hard Dizk 1 [5T31608154A5] Efrf 1]6_2?6(333
.i‘_J,.l-- @) 0] w) [E)
13 £34/GE NTFS 66 GENTFS

Q To avoid any possible problems, the new partition will in no way be created as the first
partition of the disk which already contains at least one partition.

And its size. If there are blocks of the free space on the disk, the wizard will merge them all and allocate the
resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent
partition. However, the size to take can be customized by moving the slider.
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You can select ether a block of unallocated space from the disk or an sxasting partition fos whach e unused
space will be used 1o creste & new paitition

Baszic Hard Digk O [Maxtor Ar250P0)

l@ﬂ l@w
182.1 GB NTFS 516 1GE Nt

New wolume - cument size iz 51.6 GB

Mim \olumne Size: 0 Bytes Max Volume Size: 156.5 GB

i

- In case the second option has been marked, the wizard enables to choose an existing primary partition to
install a new operating system.

On this page you can choose an exatting pimacy partiion where pou would ke 1o install 3 new operating system
Basic Hard Disk 0 (Maxtor 7Y250P0)
lq!) ..@(') leu,,
30 163.3 GB NTFS N 337.GB

Total size: 163.3 GB
Basic Hard Disk 1 (ST3160815AS)  [Used: 77.2 GB

Free: 86,1 GB
I Q) -- l w) (D)
j L 634 GB NTFS

w) (E)
66 GB NTFS

.A Your computer may fail if any other OS has already been installed on the selected partition.

e Partition properties.
ez, | wanl bo format the pastition
Partition typec | BPNTFS w

Asagn the followng dive letter:  [TIERN ~
Suace testlavel | Hone v

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only file
systems that can be correctly placed to the selected partition, taking its capacity into account.

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and

mark them unusable in the file system metadata.

e OS Label. Enter a label for the selected partition in the textual field. It will later be used for the drive
identification.

05 labels vall be dizploved in the Boot Manages’s slaitup merm bo help you boot the requined opesating
syshem,

05 label 'wWindows 7]
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Result

As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the
computer to launch the installation procedure.

The program will update your MBR, so most likely you won’t be able to start up any of the
previously installed operating systems. Please launch the Boot Manager Setup Wizard after
the installation has been completed to fix this issue.

Available operation scenarios:

e Creating Dual Boot Systems

Moving/Resizing Partition
The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data.

In order to move/resize a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Move/Resize Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Define parameters of the operation.

-

@ Are you sure you want to move/resize system volume (C:)?
S
1 You are about to move,/resize NTFS volume [No label), (C:)

Basic Hard Digk 0 (VMware, VMware Virtual S SCSI Disk Dey)

I ) Local Disk (C:)

2823 GBNTFS

Volume size 288776 MB || 11923 MB -283.781 MB
Free space before. 037 MB +| ] Obytes -277.850.73 MB
Fres space after.  |4.85 MB S| Obytes - 277,850.76 MB

e Volume size. Define size (in Mb) of the modified partition.

e Free space before. Define the partition position (in Mb) relative to the beginning of the available range of
disk space.
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e Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk
space.

e Sector to sector move. Mark the checkbox to move the partition in the sector-by-sector mode to process its
unused space as well. This can help to avoid problems with hidden data created by certain applications or
the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

Q When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting
Windows and interrupting its work, providing 100 percent guarantee that your data is kept
intact.

4. The operation will be performed immediately after confirmation.

Available operation scenarios:

e |ncreasing size of a system partition by taking unused space from any other

e Shrinking a system partition to increase size of a data partition

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the
operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the
requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system
metadata and user files.

The program enables to convert the following file system types:
- FAT16 > NTFS, FAT32

- FAT32 > NTFS, FAT16

- NTFS > FAT16, FAT32

- Ext2 > Ext3

In order to convert a file system you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Convert file system...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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3. |Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Convert button to confirm the operation.

o

k. Are you sure you want to convert system volume (C:)?

e New file system. From the pull-down list choose a file system you would like to convert to. Actually the
program only displays variants available for the operation, taking into account the current parameters of the
selected partition and limitations of the used file system.

e New cluster size. Define the cluster size for the partition. This parameter can have a profound effect on the
overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better
performance, because of less fragmentation. So be particularly careful with it.

The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it

A into half.

You may only decrease the current cluster size.

e Surface test level. Define the level of the surface check to make the program find bad and unstable sectors
and mark them unusable in the file system metadata.

4. The operation will be performed immediately after confirmation.

Changing Cluster Size

Cluster size is one of the crucial parameters of any file system. Its value implicitly affects the performance of the files
input-output activity since it defines the size of the file system metadata. Besides, the so-called waste space factor also
depends on the cluster size.

In order to change the cluster size of a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Modify > Change Cluster Size...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Define the cluster size for the partition. This parameter can have a profound effect on the overall performance.
In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of
less fragmentation. So be particularly careful with it.
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-5 ]

Are you sure you want to change cluster size for partition (C:)?

provide more effective usage of disk space

Ploase erter new cluster $i26 in sectors _L

c The Cluster Size value is expressed in Sectors Per Cluster. To get the Cluster Size in Kbytes,
divide it into half.

4. The operation will be performed immediately after confirmation.

Making Logical/Primary

The program allows you to include a primary partition in the extended partition, or exclude a logical partition from the
extended partition, without partition duplication.

In order to change a partition type you should take the following steps:
1. Select a primary or logical partition on the Disk Map.

2. Select in the Main menu: Partition > Modify > Make Partition Logical/Primary.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Are you sure you want to make the partition logical?
- You are about 1o make the paation (C:) [No label). NTFS logca

Yes No

The Make Primary > Logical option is only available when the selected partition is adjacent

g to the extended partition and vice versa.
The Make Primary > Logical option of the system partition will result in inability to boot the
operating system.

3. The operation will be performed immediately after confirmation.

Changing Partition Attributes

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



88
Mark Partition Active/Inactive

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
1. Select a primary partition on the Disk Map.

2. Select in the Main Menu: Partition > Mark Partition as Active/Inactive.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

9 =
i Are you sure you want to set the volume as active?

You are about to set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

e

Yes j No

3. The operation will be performed immediately after confirmation.

There can only be one active partition on a hard disk, otherwise your operating system will
fail to boot.

Hide/Unhide Partition

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
1. Select a partition on the Disk Map.
2. Select in the Main Menu: Partition > Hide/Unhide Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.
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Set Label of a Partition

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Modify > Change Volume Label.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Enter a label for the selected partition.

o s
Are you sure you want to change label on volume (F:)?
! Please specy 3 volume label for easier recognition of your volume

Please enter new volume label:  New Volume

e

4. The operation will be performed immediately after confirmation.

Change Partition ID

Partition ID is a file system identifier. It is saved in the Partition Table and is used to quickly detect a partition of the
supported type. By manually changing its value, you can manipulate accessibility of partitions.

In order to change a partition ID you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Modify > Change Partition ID...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Setanew ID for the selected partition.

R ==
Q Are you sure you want to change system ID of the partition (F:)?

Cumert system 1D is Ox07 NTFS. Changing system 1D might prevent some
operating systems from working with the partition.

©) | Please select predefinad 1D from the kst: |
<07 NTFS =

Please enter ID manually
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e Predefined ID. Select from the pull-down list the required ID.

e Enter ID manually. With the spinner control set the required ID value. It has to be a 1-2 digit hexadecimal
number.

4. The operation will be performed immediately after confirmation.

Change Serial Number of a Partition

FAT16, FAT32, and NTFS file systems include the Serial Number parameter. A partition's serial number is saved in the
boot sector. Its value is generated while formatting.

The program enables to modify the serial number parameter for FAT16, FAT32, or NTFS partitions without re-
formatting.

In order to change a serial number you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Modify > Change Serial Number.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Enter a new serial number for the selected partition. It should contain 8 hexadecimal figures (0..9 or A..F). The
operation cannot proceed until you enter all 8 symbols.

T ||
Ame you sure you want to change serial number of volume
&
Your computer may no longer boot or work comectly
Flease anter new senal number in hesadecmal format
ZEDE-TD16-DE7C-0091)

4. The operation will be performed immediately after confirmation.

Hard Disk Management

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Converting Dynamic MBR to Basic

The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its
contents intact.

In order to convert a dynamic MBR disk into basic you should take the following steps:
1. Select a dynamic MBR disk containing simple volumes on the Disk Map.
2. Select in the Main Menu: Hard Disk > Convert to Basic...

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to
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choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks
within the Extended partition.

Bl =<~
>

@ Convert dynamic hard disc to basic?

¥ the disc has more than four simple volumes, the first three of them will become
peimary partitions, and the rest will be converted to the logical ones

The hard disk after convent

Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dey)

l New Volume (H:)

The resulting basic hard disk can have no more than 1 pemary parttions
Please salect how many pemary parttions the basic disk should have

.

The program can only process dynamic disks containing solid simple volumes (without
extension).

Converting GPT to Basic MBR

The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk while
keeping its contents intact.

In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps:
1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map.
2. Select in the Main Menu: Hard Disk > Convert to Basic MBR Hard Disk...

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the
number of primary partitions. The rest of them if any will automatically be converted to logical disks within the
Extended partition.
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-9 s

Q Convert the basic GPT hard disk to a basic MBR hard disk?

¥ there are more than four volumes on the disk, only the first three may become
primary, and the rest - logical

The hard disk after convent

Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dev)
l l New Volume (H:)
198 GB NTFS

The resuted hard disk should have at least 1 primary pastition(s)
Please salect how many primary paditions you need

2

The program can only process dynamic GPT disks containing solid simple volumes (without
extension).

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
Launcher

1. Select a hard disk on the Disk Map.

2. Select in the Main Menu: Hard Disk > Update MBR.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Ea—=

i Are you sure you want to update master boot record?
£=2 Cument MBR contents for hard disk number 0 wil be lost after this operation. Your

computer may no longer boot comectly
=

3. The operation will be performed immediately after confirmation.

Changing Primary Slot
Different operating systems apply different approaches to enumeration of the primary partitions.

In Linux:
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In Linux, every partition has a special symbolic name that encodes a hard disk containing a partition, and a partition
itself. Partitions are addressed and accessed by using their symbolic names. Symbolic names are automatically
generated by Linux in accordance with the order of hard disks in BIOS and the order of partition records in the Partition
Table. Thus changing enumeration of the primary partitions can lead to changing of paths to some important resources.

In DOS:

The last versions of MS-DOS use a rather sophisticated algorithm for a drive letter assignment. A drive letter, which is
assigned to a partition, depends on the order of records in the Partition Table. Thus changing enumeration of the
primary partitions affects the drive letters assignment. In early versions of MS-DOS, it could even lead to the
unavailability of a partition.

The program provides the ability to change enumeration of the primary partitions. This feature will allow you to fix
problems concerning an inappropriate order of partitions.

In order to modify enumeration of the primary partitions you should take the following steps:
1. Select a hard disk on the Disk Map.
2. Select in the Main Menu: Hard Disk > Change Primary Slot.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

a
Q Are you sure you want to change primary slots order?
You are about to change pemary slots order on Basic Hard Disk 1
(VMware, VMware Virtual S SCSI Disk Dev). Your computer may no
longer boot comectly
Siot No . Object type Fle System Volume label
0 Primary FAT32 [No label]
2 Primary Linux B3 NEW VOLUME
3 Pnmary Linux Swap2 [No label]
) (&
Name Local Disk (F:)
Volume label: [No label]
Total size 24GB File system: NTFS
Used space: 363 MB Free space: 23GB
Start sector: 7261380 End sector: 12321854
No

3. Inthe opened dialog you can see the current enumeration of the primary partitions of the selected hard disk in
the Partition Table. To help you distinguish partitions from one another, the program provides the following
parameters for every partition:

- Slot

- Volume

- Partition type
- File system

- Partition size
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- Volume label

There are two buttons on the right to move the selected partition up and down within the primary part of the
Partition Table.

4. The operation will be performed immediately after confirmation.

Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

To get properties on a partition/hard disk, please do the following:
1. Choose a partition/hard disk on the Disk Map.

2. Select in the Main Menu: Partition/Hard Disk > Properties...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

=
General| | Fie System Info ] Advanced

Local Disk (C:)

Volume: label: [No lsbel)
File system: NTFS
Type: Prmary
Capacity: 4393GB
536.868,814.848 Bytes
1.048.571,904 Sectors
Used by data: 53GB(1%)
10,016,497 664 Bytes
19,563,472 Sectors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.
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Volume Explorer

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to
FAT16, FAT32, NTFS, Ext2FS, Ext3FS, Ext4FS file systems. Besides it enables to access Paragon backups as regular folders
to explorer their contents or to retrieve certain files.

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer:

Disk View | Scheduled Tasks | Archives | Help

Mame Size Modiied
| & Gl CD/DVD Drives
B = ) Hard Disks
7 [Z] 1. VMware, WMware Vidual 5 SCSI Desk Devi S00GE
5 [E] 2. VMware, Viware Vidual S SC5I Disk Den 0GB
# {5 1. Prmary FAT22 [E) 340GE
= B2 Primasy NTFS F) 24GB
+ EEF 9/2/2009 4:19:34 AM
7 o 5 /272009 4:24:46 AM
o @ P oren 14GB
#- {594, Primary Linuce Swap 509.8 MB
7 [Z] 3. VMware, VMware Vidual S SCSI Disk Devi 0GB
: % [Z] 4. VMware, Viware Virdual 5 SCS1 Desk Devi IGPT Disk)
B @ O] viual Drives

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

@, Select a destination folder for the export operation |2 |f3e]
lookin: | FllocaiDeskic) [+] & % 2

@ Address; C./

Disk Drivas Mume Date
BB locaiDskic)
@ - (5)OVD AW Drive (D)
# [E] Local Dk (E)

Hetwork Placss # [Z] Local Disk )
# [5] Archaves (G)
#- [£] New Viohume (H)

o) [ oo

Available operation scenarios:

e Restoring separate files and folders from a backup

File Transfer Wizard

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to
CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by
a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon
backups as regular folders to browse through their contents or copy required files.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



96
Startup

e Select in the Main Menu: Tools > File Transfer Wizard.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the transfer operation:

e Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it
is possible to map a network drive.

Source

[5] Local Disk () I} o R @

N () DVD RW Drive (D) .

[5] Local Disk (E)

[5] Local Disk (F)

(] Archives G)

[Z] New Volume (H) E
@) Physical partitions

v NEW VOLUME, Disk 1
I Network places .

CI] Network -

e Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the
Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane
by pressing the appropriate buttons.
Clipboard Source
Name  Source Path 7] Local Disk (F) ] @R %
limages F/images/

Name -
1 O CNg 3y

7 hibedi sys
B %, pagefie sys
» [%]somecmd emd
$ DVD RW Drive (D)
= [5] Local Disk (E)
[Z] Local Disk (F) E
i

System Volume Information -
Total data size: 132.8 KB

A Files/directories deleted from the Clipboard remain intact on source disks.

e Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to

physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will
be stored.
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There are several ways the Wizand can store your data. Plese selact how would you like to save the data:
® | Save data to local/hetwork drives. |
Crvenwribe masting files
Save dala to physical partitions
Bum the data to CD or DVD

e Revision of changes. The Transfer Summary page provides structurally divided information on all the actions
made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the

required hyperlink.
Please overview the transfer options. You can retum to the comesponding page and change the options by clicking on title
hypedinks

Obiacts to transfer
Object(s) selected: 1
Total data size: 132.8 KB (136,024 Bytes)

Transfer destination
Destination path: C/
Space available on destination: 4906 GB (526,821.834 752 Bytes)
Overwrite existing files: No

Result
After the operation is completed the required data will be placed into the specified destination.
Available operation scenarios:

e Copying of data from the corrupted system disk to another hard disk

e Burning of data from the corrupted system disk to CD/DVD

e Copying of data from a backup to the corrupted system partition

e Restoring separate files and folders from a backup

Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Assign Drive Letter...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



o)
\ Assign a drive letter?

L This allows access to the volume by using the drive letter assigned. The
assignment is not recommended f the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Remove Drive Letter.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

f system.
After having processed partitions with installed software, some programs may not run
properly.

Defragment Partition

Defragmentation is the process of rewriting parts of a file to contiguous sectors on a hard disk to increase the speed of
access and retrieval. When files are updated, the computer tends to save these updates on the largest continuous space
on the hard disk, which is often on a different sector than the other parts of the file. When files are thus fragmented,
the computer must search the hard disk each time the file is opened to find all of the file's parts, which slows down
response time.

The program provides the necessary tool for the defragmentation of NTFS and FAT partitions.

In order to start the operation you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Defragment > Defragment Partition...

A There are other ways to start up this function, please consult the Interface Overview
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chapter to know more on the subject.

4.

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Yes button to confirm the operation.

Co- ) |

Defragment wolume (C:)7

Defragmentation may improve peformance of your system. For locked
volumes, howenver, this operation will require the system restart.

Directories placement
Put drectones: Leava asis [ ]
Sort options
Sort bry size Do mot soet 3
Sort by modfication time: | Do not soet -]

%) More cptions Yes [ ]

e Directories Placement. From the pull-down list select the way how to sort directories.
e Sort by size. Sort files according to their size.
e Sort by time. Sort files according to the last time of update.

In addition, there is the possibility to make further detailed settings (although the default values will do in most
cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page:

System files options
V| Do not save content of pagefila sys and (or) hiberfi sys

Pagefile sys and Hbedile sys are OS5 temporary files and are only usad for
the curent Windows session. Thus excluding them from processing will
reduce time required to accomplish the operation

Defragmentation options
9 Safe mode frecommended)

The operation may require a lot of time to complete, but it guarantees
consistency of your data. Pleasa use this mode when your computer is not
going to be in operation for a considerable penod of time

Fast mode

The operation will go much faster, but there's a chancea of loosing data
because of a power outage. Please make a backup of your data before
using this mode

e Skip auxiliary files. Mark the option to ignore contents of the PAGEFILE.SYS and HIBERFIL.SYS system files.
These files are used temporarily in the operating system.

o Defragmentation Mode. Select the preferable defragmentation mode.

The operation will be performed immediately after confirmation.

Available operation scenarios:

Hard Disk Optimization
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Defragment MFT

The MFT (Master File Table) is an NTFS system file that contains in-depth information on files, including size, time and
date stamps, permissions, and data contents. In the course of time the MFT file can also be fragmented, thus slowing
down the speed at which data is accessed.

The program enables to defragment the MFT file.

In order to start the operation you should take the following steps:
1. Select an NTFS partition on the Disk Map.

2. Select in the Main menu: Partition > Defragment > Defragment MFT...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

ﬁ' LI
My Defragment volume’s MFT?

The MFT Defragmentation may mprove pedomance of your system. Forlocked
volumes this operation will demand to reboot

Yas ]

3. The operation will be performed immediately after confirmation.

Compact MFT

The program enables to re-write MFT (Master File Table) in a more compact way to increase the access speed to files on
NTFS partitions.

In order to start the operation you should take the following steps:
1. Select an NTFS partition on the Disk Map.

2. Select in the Main menu: Partition > Defragment > Compact MFT...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the
Yes button to confirm the operation.
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<=
@} You are about to compact the Master File Table (MFT) on
i/ volume (C:)?
Please specify an operation parameters
7! | Compact records {moving to the head of the table) |
v Truncate MFT sfter compacting
|  Yes | No

e Compact records. Mark the option to re-write MFT records and shift them to the head of the table.
e Truncate MFT after compacting. Mark the option to remove table rows emptied during the operation.
4. The operation will be performed immediately after confirmation.
Downgrade NTFS Version

With our program you can decrease version of an existing NTFS partition. This feature can be particularly useful when,
for instance, dealing with different versions of the Windows NT family operating systems.

In order to start the operation you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main menu: Partition > Modify > Downgrade NTFS Version...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Decrease version of the selected NTFS partition by selecting the one you need from the pull-down list.

7| e
"#s.  Are you sure you wanl to downorade NTFS version for
._@ wolume [C:)7?
Cument NTFS version is 3.01 - Windows XP

Select new NTFS verson: [P L =

Yas Mo

4. The operation will be performed immediately after confirmation.

Change SID

SID - Security Identifier is a binary structure that is associated with some object in the system and is used to distinguish
between user access privileges in workgroup local networks. By default, the SID Changer searches Windows installations
and then changes SIDs in the found Windows instances to automatically generated random SID values.

To change SID of the desired Windows installation you should take the following steps:
1. Select a hard disk/partition on the Disk Map.

2. Select in the Main Menu: Partition/Hard Disk > Modify > Change SID...
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There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

(-2 ()
i Are you sure you wanl lo change 51Ds for Windows
| instances on volume (C:)7

SID changer opticns
@ | Generate SID based on BOOT INI fles information. |

Additionaly lock-up the dreciones listed below

Look-up only the deeciones lsted below

Yes [ o

3. By default, the utility searches for a BOOT.INI file to extract information on a Windows installation and then
performs modifying of the found SID by an automatically generated random value. However you can manually
set a directory to search for a Windows installation.

A The SID changer utility can be applied only to NT and Win2k installations.

Test Surface

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
1. Select a partition or a block of free space on the Disk Map.

2. Select in the Main Menu: Partition > Test Surface...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. From the pull-down list choose the level of the surface check.

-5l

% Test surface of volume (C:)?

Testing volume surface allows 1o find bad blocks and other peoblems

Please select a suface test level: [N ~
| Yes ‘ No
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4. The operation will be performed immediately after confirmation.

Check File System Integrity

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Check File System Integrity

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

<
'\\ Check volume (C:) [No label]. NTFS for errors?

1 Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

3. The operation will be performed immediately after confirmation.

Edit/View Sectors

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks
providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate
through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:
1. Select a hard disk/partition on the Disk Map.

2. Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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R ==
Edit sexctors on Basic Hard Diske 0 (Viware, Viwae Virtual 5 5051 Disk Dew)
Cuerent sactor ia Dof 1,048.575,999.

Plase selec sector s [0 D BB EB8QA-S¢v HeE B R

Ox0000000000 33 c0 8= d0 be 00 7c 8= c0 8e di be 00 7c bf 00 3hoPM. LA BN L -

Ox00000000L0 06 b2 00 02 fc £3 ad S50 68 1lc D6 cb fb b9 04 00 JbiiddPh. CEQY ..
0=x0000000020 bd be 07 80 7e 00 00 7c Ob Of 85 Oe 01 83 5 10 L2 S A
0x0000000030 a2 £1 od 18 88 56 00 55 cé 46 11 05 c& 46 10 00 &%l . V.UEF, EF,
0=0000000040 b4 41 bb aa 55 cd 13 5d 72 0f 81 fb 55 aa 75 09 “hnd UL ]y, Al

Ox0000000050 £7 1 01 00 74 03 fe 46 10 66 &0 80 7= 10 00 74 =A. .t.PF.E" .~ .t
0x0000000080 26 &6 &3 00 00 00 00 &6 £f 76 03 &3 00 00 &3 00 &Eh fyv.h..h

0x0000000070 Pe &8 01 00 68 10 DD b4 42 8a 56 00 8b £4 ed 13 |b. k.. "B.V..A&L
Ox00000QDOOBOD  9f 83 c4 10 9= eb 14 b8 01 02 bb 00 7c 3a 56 00 ohoE el | LY.
00000000090 8a 76 01 8a 4e 02 8a 6o 03 cd 13 66 61 73 lc fe v..H. .nl fas.b
0x0000000040 4e 11 75 Oc B0 7e 00 80 Of 84 8a 00 b2 80 eb 84 Hou, .~ 1.8

0x00000000B0 55 32 =4 8a 56 00 od 13 5d eb 9= 81 3= fe 7d 55 U2a V.1 ]2, :b}0
0=00000000C0  aa 75 6= £f 76 00 =8 8d 00 75 17 fa bl dl =6 64 duniv. &, u. 0" Hed
Ox0000000000 o2 83 00 b0 df eb &0 o8 7c 00 bD ff o5 64 28 75 &. . "Be'é|. "yedéu

0x00000000EQ 00 fb BE 00 bb od 1a 66 23 0 75 3b &6 81 fb 54 i, wl f8Au:f 4T
0x00000000F0 43 50 41 75 32 81 £9 02 01 72 2c &6 63 07 bb 0O CPAuz. 4. .xr, fh.».
Ox0000000100 OO0 &6 &8 00 02 0D DD && &8 03 DD 0D OO 66 53 &6 Eh....th. .. ESf

0=x0000000110 53 66 55 &6 &8 00 00 00 00 &6 &8 00 7c 00 00 &6 Stlth th.|. . £
Ox0000000120 &1 &8 00 00 07 ed 1a Sa 32 f6 =a 00 7e 00 00 od sh, .1 7254 |..1

0x0000000130 18 ad b7 07 eb 08 ad bé 07 eb D3 ad bBS 07 32 a4 N N RN T
0x0000000240 05 DD 07 8b £0 ac 3c 00 74 09 bb 07 00 b4 Oe cd R ST TR T
0=0000000150 10 eb £2 £4 eb £d 2b c% 4 64 b 00 24 02 =0 £3 eodep+Esde . & se

0x0000000160 24 02 3 49 be 76 61 6o 69 64 20 70 61 72 74 69 $ KInvalid parti
0x0000000170 74 6% 6f 6= 20 74 61 62 6o 65 DD 45 72 72 &f 72 tion table Error
Ox0000000L80 20 &c &F &1 64 69 &e &7 20 &f 70 &5 72 61 74 &9 loading operati
0x0000000190  ée &7 20 73 79 73 74 65 éd 00 4d 69 73 73 &9 de ng system Missin
0x00000001A0 &7 20 &6F 70 &5 72 61 74 69 6& &7 20 73 79 73 M4 g opsrating syst
0x00000001EB0 &5 &d 0D OO0 OO0 &3 7b %a bb c2 83 1d 00 00 30 20 em. . .of wh. ...
Ox00000000C0 21 00 O7 fe £f £f DD 02 00 OO0 DO £0 7f 3e 00 0O V. . byy & >
0x00000002D0 00 OO0 00 OO 00 OO0 OO OO0 00 OO0 OO 0D 00 OO0 OO0 00

0x00000001E0 OO0 OO0 OO OO0 OO0 OO0 OO OO OO0 OO0 OO OO OO0 OO0 OO QO .. ... ...........
O0x00000001F0 OO0 OO0 DD 00 00 0D DD OO0 OO0 O0D DO 0D OO0 OO0 55 as .. ............ LE] hal |

A Careless use of the Edit Sectors function may result in the irreversible data corruption.

Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:

1. Callthe Send Log Files dialog in the Main Menu: Tools > Send Log Files;

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Provide a customer name and a product serial number;
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3. Give a detailed description on the encountered problem.

Send log files

/; Send log files.
" Please enter short description of your problem and send log fles bo support

Customer Name
John Smith
Serial Mumber
(% de-654ac-a4%c-Tdaf §-237a2|
Conbent of inguiry
Help!

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files
and then send it to the Paragon Support Team.

Log Files

Log files are simple textual files that can be opened by any text editor. There are several log files automatically
generated by the program:

Stubact.log Contains in-depth information on parameters and performance of all operations
carried out by the program

Pwlog.txt Besides brief overview on operations it also contains detailed information about the
state of all hard disks®

Cdb.log Contains low-level information on the CD/DVD devices used in the system

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain
valuable information on Windows family operating systems

Log files do not contain any confidential information on the operating system settings or
the user documents.

A The Send Log Files function is only available when outgoing mail server (SMTP) and the user
e-mail address are properly set. To learn more about it please consult the Settings
Overview chapter.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files
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Started 9702009 at 12-40:12 AM. Firished at 12:40:29..
Started 9732009 at 12-40045 AM. Finished at 12:41:21...
Started 9732009 at 12-42:11 AM. Freshed at 12:4429
Started 3732009 at 12-45:04 AM. Firished at 12:45:12...
& Started 9°3/2009 at 12-45:19 AM. Freshed at 1:28:51
& Started 3722009 at 31740 AM. Finished at 3:21:28 AM N operations have besan found for the sslected session.
& Started 922009 at 3:30:36 AM. Finished at 3:41:04 AM
# Started 3722009 at 3:41:05 AM
& Started 922009 at 12-15:48 PM. Freshed at 12:20:26...
& Started 3722009 at 12-20-26 PM. Frished at 12:24:46..
# Started 922009 at 12:24:456 FM
# Sared 922009 at 12-06:15 PM. Freshed at 12:0747...
& Stared 922009 at 12-07:47 PM. Frished at 12:21:18...
¥ Stated 3722009 at 12-27:18 PM. Fnished at 12.30:15...
Started 97272009 at 1230015 PM. Finished at 12.31:33..
Sarted 37272009 at 12-31:33 PM. Finished at 12:41:47...
Started 9722009 at 12-44:44 PM. Finished at 12.58:38...
#- Started 3722009 at 1:08:03 FM

Cisk System Configuration Bafore Season Cisk: System Configuration After Session
Basic Hard Disk 0 (Viware, Viware Vidual 5 SC51 Disk Dey) - OF Basic Hard Disk 0 (Viware, Viware Virdual 5 SC51 Disk Dev) - OF
@ (C) @ (C)
NTF5 NTFS

Basic Hard Disk 1 (Viware, Viware Villual 5 SC51 Diske Dey) - OF Basic Hard Disk 1 (Viware, Viware Vidual 5 SC51 Diske Dev) - OF

P  P—
FREE FREE

Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS1 Diske Devy) - OF Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS51 Diske Dev) - OF

 [h— o —
FREE FREE

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.

Backup Scenarios

Backing up a hard disk or partition to external media (CD/DVD)

To back up an entire hard disk or a separate partition and then burn the resulted image to CD/DVD, please do the
following:

1. Click the Back up a Disk or Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. On the Wizard's Welcome page, click the Next button.

3. Onthe next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on
the chosen task.
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Click the check box next to any hard disk drive or partition you want to back up

[ — Type =
| & G My Computer My Computer ‘
© [ [5] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev)  Intemal Hard Disk Drv
& [ 25 First Hard Disk Track First Track

m

= ;,JQFNMMTQCR Frst Track
] € Master Boct Record MER
] &P Local Disk (E) Prmary =
] @ Local Disk () Prmary
] L= Local Diek (7) Primary
7] © Loca Disk () Primary

2 71 [5] Basic Hard Disk 2 (VMware, VMware Vitual S SCSI Disk Dev) intemal Hard Disk Driv ™
»

| €| sl

The size of objects to back up: 499.9 GB
Estimated archive size 7.2 GB

You’ve got the option to modify the default backup settings by marking the appropriate
checkbox on this page.

4. On the Backup Destination page, select the Burn the data to CD or DVD option.

There are several ways the Wizand can store your data. Please select how would you ke 1o save the
archive:

) | Save daia to the Backup Capsule |

) Sawve data to local network dives,

) Save data to physical paritions.

) Save datato FTP locations.

@ Bum tha data to CD or DVD.

5. Select a recordable device on the list of available CD/DVD devices and edit the archive name, if necessary.

Select a recorder to bum archive images to.

& Optiarc DVD RW AD-71704 CD-R/RW; DVD-R/RW; DVD-RAM; DVD+R/RW
<& CD Bumer Emulator CD-R/RW
& DVD Bumer Emuistor DVD+R/RW

Archive detals

Archive name: BP030909 {(No more than 8 symbols and only in English.)

Estimated archive size: 4.4 GB
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Please take into account the Estimated archive size value. It can give you a hint about the
number of CD/DVD discs required for the operation.

6. Add comments to your backup describing its contents.
Plaase enter a shod comment bo describa the archive

F
~ o comment

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished with our recovery media.

Backing up a hard disk or partition to a network drive

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do
the following:

1. Click the Back up a Disk or Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Onthe next page, mark the appropriate option opposite a hard disk’s name or a partition’s name depending on
the chosen task.

Cick the check box next to any hard disk drive or partition you want to back up

Name Type -
= Gl My Computer My Computer
@ [7] Basic Hard Disk 0 (VMware, VMware Vitual S SCSI Disk Dev) intemal Hard Disk Driv
#55 First Hard Disk Track First Track
(£ Master Boct Record MBR 1
€2 Prmasy 1
{=] Basic Hard Disk 1 (VMware, VMware Vitual S SCS! Disk Dev) intemal Hard Disk Driv
£ First Hard Disk Track First Track
(& Master Boct Record MBR
(& Local Disk (E) Pamary
& Local Disk ) Prmary
Local Drek (7) Primary
€ Local Disk () Prmary

[Z] Basic Hard Disk 2 (VMware, VMware Vitual S SCS! Disk Dev) intemal Hard Disk Driv ™

‘4 ’

/’.\) The size of objacts to back up: 499.9 GB
1 Estimated archive size 7.2 GB

You’ve got the option to modify the default backup settings by marking the appropriate
checkbox on this page.
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On the Backup Destination page, select the Save data to local/network drives option.

There are several ways the Wizard can store your data. Please select how would you ke to save the
archive

Save data to the Backup Capsule

@ Save datato local/network drives

Save data to physical parttions
Save data to FTP locations
Bum the data to CD or DVD.

5. Map a network disk to place your backup image to:

Call the Map Network Drive dialog by clicking the appropriate button;

Select a folder whene archive should be placed and specify archive name. Archive name will be used a5 8
subfolder where backup data fles will be sloned

Archive location: |C-/arc_030305071551273/ 2 X Y
Namd 5 Map Network Drive [ 2 =] pe
Remate kocation mapping
Anetwork share || ,_

Map to drive better : | Z !Zl
Make permanent connection

¥) Connect as user : [ Cance

Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;
Define a letter from the pull-down list of available drive letters;

Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current
Windows session;

Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

Edit the archive name if necessary.

Please specify the archive name. Archive name will be used as 3 subfolder where backup data fies wil
be stored

Archive detais

Archive name arc_030509071001085
Estimated archive size: 44GB
Space avaisble on backup destnation: 38 GB

A

Please take into account values of the parameters Estimated archive size and Space
available on backup destination - if the archive size exceeds the available space, another
network drive needs to be selected.

7. Add comments to your backup describing its contents.
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Plaase enter 3 shod comment to describe the anchive

5 Mo comment

8. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished with our recovery media.

Backing up a dual boot Mac to an external USB drive

To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB
drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (Normal Mode),
since it’s the only mode that provides support for Mac computers.

4. Inthe Linux launch menu select Partition Manager.

5. Launch the Backup Wizard by selecting in the Main Menu of the program: Wizards > Backup Wizard.
Operations Help

d GPT Disk 0 (v Copy Hard Disk
One Bunon Copy Wizard

Simplé

isk 1 (28)-279(

.I - NTFS Undelet: Paritions FS dbp

File Transher Wizard

HTFS [Ho label]

Boot Correcion
Disk drive, Size 112 Gb

'W Metwork Configurator sed [Free |Volume label
ad GPT Disk D (Size 112 Gb)

Primary FAT32 200 Mb 15.0 Mb 185 Mb EFI

Primary Apple HFS 549 Gb 14 2 Gb 40.7 Gb leapard

Primary Free 128 Mb

Primary NTFS 56.6 Gb 1049 Gh 45.7Gb  [Molabel)

6. On the Wizard's Welcome page, click the Next button.
7. On the What to back up page, select your Mac hard disk.
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[retained GPT Disko | Model VMware Vinual IDE Hard Drive, Size 112Gb
[N Tvolume [Type |File Sysiem  [Size Jused [Volume label  JActive | |
Retained GPT Disk 0 (Size 112 E-'E-'-
1 - Primary Appl HFS 549Gh 14.2Ghb leopard Mo
] = Primary HTFS %66 Gb 105 Gb [Ha label] Yes

8. On the Backup Destination page, select the Save data to any local drive or a network share option.
Please select how woulkd you like 10 §ave the anchive

(%) save data to any local drives or a network share

Choose this option if you want o save your data o kocal
mounted or physical partition, 1o USB or FireWare exiernal
drives and 1o a mounted network share. You will be prompred o
choose & kcation you want 1 save the achive 1o,

) Burn data to €O/DVD

Choase this option if you wan! the Wiz ard 1w burn the archive o
CDor DVD. You will be prompted 1o choose a CDor DVD RW
drive.

9. Select an external USB drive as a backup destination.

Specify image file to create

Loak in: [H:, (NTFsS, 2 on Disk 1) (UFSD disk - 4bp) ~| [E ]
| rchive
) SRECYCLEBIN
I -Trashes
;‘:_
() RECYCLER
) System Volume Inform ation I El
I head
4|5 s
Q[ rRemamerm | [ Mewbider(F | [ Delewe(F® ]
File name: [In‘-n_,Dﬂ plbl I I Save |
File type: [image files (* pbi v | | Cancel
| <Bak | Hex> | | Cancel |

10. Edit the archive name if necessary.

~ Backup destination

Archive name:

00.plbf 1)

Space available on destination: 34.8Gb

I-Ill'lf' 1/Pan2)Backup Sorageimg

Approximate archive size: 17.5 Gb

Please take into account values of the parameters Estimated archive size and Space
A available on backup destination - if the archive size exceeds the available space, another
drive needs to be selected.

11. Add comments to your backup describing its contents.
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Archive @exi comment

Please enter backup comments 1o describe the archive

Archive Img_D0.pbi, created: 20080605 13:42:30 I

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the
Next button to start the backup process.

A This operation can also be accomplished under Windows.

Recovery Scenarios

Fixing MBR after a boot virus attack

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack,
thus your system fails to boot.

To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. Onthe Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option.

Flease choose the operation

() Search for Windows installations 1o correct
(*) Correct the Master Boot Record (MBR)

() Correct the partition beot record

) madify paniion parameters

() Correct boot paramessrs (bost.ini, BCD)

To begin, click Next
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5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update
the MBR executable code option.

Please choose the hard disk o correct boot problems

Flease pointout the operation o perdorm:

) iew the MBR
(& Updare the MER executable code

() Reorder primary paritions (change skis)

6. Confirm the operation.

ﬂ Updane the MBR executable code of the Basic Disk 0 (40,0 Gh)7?

| Yes Ho |

7. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Reporting

"4 You have successfully completed boot correction. To view the repan
on the operations pedormed, click Report.

Report

Report

Paragon Bool Correcior's Repon
Operations perdormed:

Operation #1: Correct the Master Boot Record
Hard disk targeted: Basic Disk 0

Status: Succesalul

Dave and Time: 2009 Jan 14 Wed 140109

8. Click the Finish button to close Boot Corrector.

9. Reboot the computer.

Correcting BCD (Boot Configuration Data)
To automatically correct Windows BCD, please do the following:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a
A CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set
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up to boot from CD/USB first.

2. Launch Boot Corrector.
3. Onthe Wizard's Welcome page, click the Next button.

4. Select Correct boot parameters... to let the wizard fix BCD in all found Windows installations.

@ Windows installation to comect
View the st of all windows installations and comect boot parameters

Cormect the Master Boot Record (MBR)
View the kst of all Hard Disks and corect MBR executable code on some of them

Edit/View Sectors
View, edtt, backup and restore sectors or a group of sectors on the hard disk or partition of your
choice

@ Comect boot parameters (boot ini, BCD)
Automatically comect boot ini and BCD on all hard disks in system

5. The wizard will ask you to confirm the operation. Apply the changes to complete.
" The wizard has not apphed the changes yet. On this page you can etther accept or reconsider the
[/ s\ changes

Note: ¥ you accept the changes. the wizard wil physically perform 3l operations. You won! be able to
interrupt this process or undo the changes.

k may take some time to apply the changes. You may also be asked to restart your computer during this
process.

Would you ke to apply the changes?

& | Yes. apply the changes physically. |

" No, let me

After completing the operation close the wizard, and then reboot the computer.

Fixing Windows startup ability

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything
seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
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incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option.

Please choose the aperation

(&) search for Windaws installations i cormect
O Correct the Master Boot Recard (MER)

() Correct the panition boot recond

() Modify partition parameters

(Z} Correct boot parameters (boovini, BCD)

To begin, click Mext.

5. On the next page choose the required Windows installation from the list of found installations (if several), then
select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties
button to get more info on the selected item.

Correct Windows installations

Pragram has searched for valid Windows installations an your
computer, The resuls of the search you can see below, Stas S refers
10 4 system partition (you can edit the Bootini file), B - a boot panition
{you can correct the System Registry)

N |Partiton |Status [System reat  [Type
1 Disk 0, Partition 0 5+B  WINDOWS WinXp

Far the highlighted Windows installation, please

paint out the operation o perdorm
(O Cormectdrive leners in the Sysiem Registry
@-’ Edit the Bootini file

() Camect the partition boot record

Ta continue, click Mext

6. Examine the file — maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate
buttons.
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Edit the Boot.ini file on Hard Disk 0, Partition 0

[boat loader]

timeaut=10

defauh=mulitOdiski0irdisk(Dip anition( 1IWIKDOWS

[operating sysems)

st {00di sk (Djrdisk (0p anition( IWVINDOWS ="Paragon VMWare Windows XP Pamition 017 fasudewct 1

T S | .

I Edin ] [ insert the sample I ] Add the sample ]

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to
correct drive letters in the Windows System Registry.

Correct Windows installations

Program has searched for valid Windows installations on your
compuier. The results of the search you can see below, Status S refiers
08 Sy S panition (vou ¢an edit the Boot.ini file), B - a boot panition
(you can correct the System Regisiry).

|[N |Parition |staws [Sysem oot [Type
1  Disk0, Partition O S+B  WINDOWS WinxpP

For the highlighted Windaws installation, please

point out the operation o perform:
(&) Correctdrive leniers in the System Registry
) Edit the Boot.ini file

(} Correct the partition boot record

Adjust 05 o boot on new handware

To continue, click Rext,

8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not
sure which installation you need, please use the Properties button to get more info on the selected item.

' Paritions List | Letiers Map

Bebow you can choose a hard disk drive and see all panitions on it Information about drive letiers
assigned 1o these panitions is taken from the System Registry of the Windows installation selected.

[Basic Disk 0 +| 40.0Gb, VMware Virtual IDE Hard Drive
[N [Type [actve  [File System  [Volume label [Size [Drive ieters |
0 Primary Yes  NTFS WinXP 310Gk C:
1 Primary Mo NTFS Application  9.8Gb E
2 Primary Mo BackupCapsul [No label) 100 Gb <Mane >
3 Primary Mo Free 17.2Ghb <Mone:>
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9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System
Registry.

Partitians List

Drive letters it. Information about drive letiers

the Windows installation seleced.

Letters

Basic Disk D Drive

N [Type Chinge |Drive leners

0 Primary T 13 < Mone>

1  Primary 133 E:

2 Primary Add Gh <Mones=

3 Primary — Gb <None=
Recommended to try - C:. If used,
you can release itin Leters Map.

Close

= :

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.

11. Confirm the operation.

ﬂ Apply the changes?

s

v J[ ™ |

12. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

- Reporting

|1_>_( the report

Paragon Boot Correcior's Report
Operations performed:

Operation £1: Change dive leneis

Partition targeted: Hard disk 0, Panition 0
Info: System Root folder is ™" friputer, If
Status: Successiul hnd make
Daie and Time: 2009 Jan 14 Wed 16:14:16

Save Close

8 Togo to the beginning, click here

13. Click the Finish button to close Boot Corrector.

14. Reboot the computer.

Restoring a system partition from external media (CD/DVD)

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But
you’ve got a backup of your system partition on a bootable DVD disc. That’s just enough to easily get your system back
on track again.
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To restore your system partition from a backup image located on CD/DVD when the current OS is down, please do the
following:

1. Insert a CD/DVD disc containing the previously prepared backup image into a CD/DVD drive (the BIOS must be
enabled to boot the system from the CD/DVD device).

2 This scenario implies that you have got a bootable archive on your CD/DVD.

In case the backup image is stored on several CD/DVD disks, please insert the first one.

2. Restart the computer.

3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. Inthe PTS DOS launch menu select the Simple Restore Wizard. You can find the same wizard in Linux as well.
5. On the Wizard's Welcome page, click the Next button.

6. On the What to Restore page, you can see a list of available images (if several). Most likely the required archive
will be there too. If not, click the standard browse button [...] to find it. When you find your image, double click
on it to proceed.

Select Image

| ]

You can select image from list below (on Double click)

' |Created on [Archive name
@ 2008 May 27 14:52:55  arc_27050814520067 1 PEF

= 0B May 28080354 BP2B0S08PRF

7. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.
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~ Panition preview

HTFS WinXP ‘

Archive details =
Type Image of the parition

Archive name I /BP280508 PEF

Created M08 May 28 Wed 08:03:54

File sysiem: NTFS

Drive letier; d

Valume label Win}pP

Size (capacity) 30Gh (3.216052.224 b

Used space: 1.8Ghb (B0%

Free space 1.2 Gb (39%)

SeciorsClusier: 1 =

8. On the next page specify a hard disk, then one of its partitions to restore the image to (if several in your
computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we
actually need.

Basi Disk 0 - 40.0 Gb

..:u“mm |

[Basic Disk | Size40n0ch
[N [volume [Type [File System |Size [volume label  [Active [Hidden | |
[ Primary NTFS 30Ghb WinXP Yes Mo
1 . Primary NTFS 098Gk Applic atien Mo ]
2 Primary BackupCapsule 100 Ghb [Ho label] Mo Yes
E S Primary Free 17.2Gb Mo Mo

All contents on the partition selected for restoring purposes will be deleted during the
operation.

9. On the Partition Start and Size page you can change size of the partition and its location if necessary.

~ Paniion preview

NTFS WinXP

Mew size: (1859 - 3067) Mb

Mb

-
et
Free space before: (0 - 12208 Mb

3 foer ]
0 O
b ]

Free space aher: (0 - 1208 Mb

d

-~
w Mb

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next
button to initiate the restore process.
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p—

Your partitions before operations:

e | E—

Your partitions afler sperations:
i | E—

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress

BRARRARAN L1l

1: Restore partition or disk

Operation progress

ALLLLL -‘
Time elapsed:  00:01:10 Time 0 finish 00:06:36

Copied so far:  290.0 Mb Read so far 366.0 Mb (5.7 Mb/s)
To copy L.5Gb  Write so far 366.0 Mb (52.3 Mby/s)

Overall progress

TITITIT

Restore Primary panition 0 (disk 0) from file: Z /BP280508 PBF
Data writing...

12. After completing the operation close the wizard, and then reboot the computer.

To make Windows bootable on different hardware, please additionally complete the P2P
Adjust OS Wizard.

Restoring a system partition from a network drive

Let’s assume that your computer fails to boot because of a virus attack or corruption of some system critical files. But
you’ve got a backup of your hard disk on a remote backup server. That’s just enough to easily get your system back on
track again.

To restore your system partition from a backup image located on a network drive, please do the following:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.
3. On the Restore Wizard's Welcome page, click the Next button.

4. On the Browse for Archive page you need to specify the required backup image. So you should take the
following steps to do that:
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o Select Network as a backup destination;

Look: in: Netwark j KB ﬁ' q]
3 Disk Divives
] W ) Sze | Date
[E] Application ()
o) CD Drive (E) PARAGON
[5] Boet (%3
& Backup Capsules
I Backup Capsule on Hard Disk 0
G Matwork places

s PN S

Map a network disk where your archives are placed:

Nama

w-EI N

- Call the Map Network Drive dialog by clicking the appropriate button;

Look in: IEH Natwork ;I o ﬁ “Ftt
HName Size | Dats
w: [T Bt ] )
21X
A netwods shane :I _I
Mz to drive letter : 'I
[~ | Makee pemanent connection
r A
¥) Connect as user oK Lancel |
o

- Click the standard browse button [...] to browse for the required network share or manually enter a path
to it;

- Define a letter from the pull-down list of available drive letters;

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

A You can also map a network disk with Network Configurator.

e Choose the required archive in the browser-like window. The Archive File Details section displays a short

description of the selected image.
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Name Sze | Date )
- [5] Boot (X
5/28/2008 2:37:21 AM
KB 5/28 17:24 AM
962_00kp.000 1GB 5/28/2008 2:27-10 AM
968 00000 ofm 171 KB 5/28/2008 2:37:07 AM =i

Name:  Basic Hard Disk 0 (Unknown Model)
Comment: Backup of My Hard Disk

Type: Basic Hard Disk Drive
Total size: 40GB
Fia: Z:/arc_280508103150568/acc_280508103150968 PBF

5. The What to Restore page displays detailed information about the contents of the archive. Select the required
item to restore. In our case it is the first partition of the disk.

Plaasa salact ons of the chyect(s) to restora:

Name Type Fle system | Sze | Used

(= [5] Basic Hard Disk 0 (Unknown Model) Basic Hard Disk Drive 40GB
w Primacy NTFS 25GB  18GB
L @PLocal Disk | Primary NTFS 97GB 2528 MB

| Name: Local Disk (*)
Volume label: WinXP
Fle system: NTFS Totalsiza: 29GB
Usad space; 18GB Frea spaca: 11GB

6. Onthe Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in
your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we
actually need.

Plaasa salect a place you would ike 1o rastore the archive 1o, Note that £ you selact an existing hard disk or
parttion, ts content will be deleted and replaced with the one from the archive.

[ Basic Hard Disk 0 (VMware Virtual IDE Hard Drive)
'l ' —( ARy

‘l ©) Applicati... [" ) Bado.pCi l ©) (Unallocated)
| 97GBNTFS || ¥ s9ce ‘ 17.2GB
Total size: 2.9GB

Used: 1.8G8

-

Free: 1.1G8

All contents on the partition selected for restoring purposes will be deleted during the
operation.
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7. Onthe Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size
of the partition and its location if necessary as well as assign a particular drive letter.

Your hard diek aftarthe changes

Basic Hard Disk 0 (VMware Vintual IDE Hard Drive)

I I ()] Apphicati i w) Backup C I w) (Unallocated)

Logical Disk Rastore Options

Piease specty the size of the restored padtion: [ 2067 3] 1849 MB - 3067 MB
Please spacfy size of free space before the patiton: |0 1 OMB-1217MB
Please spacify size of free space aftar the parition [_ﬂ OMB- 1217 MB

Assign the folowing dive letter |- v]
8. On the next page of the wizard confirm the operation by selecting the appropriate option.

~Would you ke to apply your changes 7
= | Yes. apply the changss physicaly. |
" Mo et me ru«:u:"mn-.‘rarlms

9. Inthe Progress window you can see in real-time a detailed report on all actions carried out by the program.
Mark the checkbox at the bottom of the window to automatically switch off the computer on the successful
accomplishment of the restore operation.

10. After completing the operation close the wizard, and then reboot the computer.

To make Windows bootable on different hardware, please additionally complete the P2P
. Adjust OS Wizard.

Restoring a system partition from a local drive

Let’s assume that your operating system gives trouble after having installed brand new software. But you’ve got a
backup of the system partition on a local disk. That’s just enough to easily roll it back to the point when run smoothly.

To restore your system partition from a backup image located on a local disk, please do the following:

1. Click the Restore item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Restore Wizard's Welcome page, click the Next button.
3. Onthe Browse for Archive page, specify the required archive:

e By clicking the Switch to Archive List View link, you can see a list of images contained in the Archive
Database (if any).
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%) Show o ] @ & 1%

| Type CreationDate ~  Source Object Sze i
ie 9/3/2009 3:57:21 AM  Local Disk () 24GB

G $/2/20095:24:27 AM  Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev) 10GB

& 9/2/2009 5:20:25AM  New Volume () 24GB

E J 9/220095:11:41 AM  Fledevel Archive 113.1KB

\[J 9/2/2009 5:06:03 AM  Fledevel Archive 4KB

= 9/2/2009233:.00 AM  Local Disk (C) 4399GB

18] 9/2/20092:21:01 AM  Basic Hard Disk 1 (VMware, VMware Vitual S SCSI Disk Dev) 10GB

« ’
Swich to File View

Acchive Fie Detals

Name: Local Disk (C:)
Comment, My system backup
Volume labal: [No label]

Fle system: NTFS Total size: 4339GB
Used space: 85GB Free space: 4914GB
Fle: G:/arc_system/arc_system PBF

To get a clear-cut picture on properties of the required image, just click on it and the section below will (i.e.
Archive File Details) display a short description.

A To know more on the subject, please consult the Viewing Image Properties chapter.

e By clicking the Switch to File View link, you can find the required image in the browser-like window. The
section below (i.e. Archive File Details) will also display a short description of the selected image.

Lookin: | [E] Archives (5:) ] @ % 2
Hame | Sze | Date [I=
= [5] Archives 153
@ | arc_disk2 9/2/2009 52500 AM
- [J§ arc_doc 9/2/2009 50542 AM |
= |, arc_images /372009 35721 AM |~
= arc_system A A0 AM |
[ 150 5272105237324 ~
Files of type: | Archive files E
Calch o Arebive L g
Archive Fle Detais
Nasie Local Disk (C:)

Comment: My system backup
Volume label:  [No label]

Fie system:  NTFS Total size: 4393 GB
Used space: BSGEH Free space: 4314 GB
Fila: G./arc_system/arc_system, PBF

A To know more on the subject, please consult the Viewing Image Properties chapter.
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On the Where to Restore page specify a hard disk, then one of its partitions to restore the image to (if several in
your computer). By default, the program offers to restore the archive exactly where it belongs. That’s what we
actually need.

Please select a place you would like 1o restore the archive 10. Note that f you select an existing hard disk or partition,
ts content will be deleted and replaced with the one from the archive

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)

I ©) Local Disk (C:)
499.9 GB NTFS

All contents on the partition selected for restoring purposes will be deleted during the
operation.

5. Onthe Restore Results page you can see the resulted disk layout. Besides there’s the possibility to change size
of the partition and its location if necessary as well as assign a particular drive letter.
‘four hard disk: after the chamges:

Basic Hard Disk 0 (VMware, YMware Virdual 5 SC51 Disk Dev)

@) Local Disk (C:)

2339 GH NTFS
Geometry Restore Options
Plzase specily the size of the restored partition: 511938 & 8713 MB - 511938 MB
Plaasa speciy size of free space before the panition: *| OMB - 503279 MB
Please speciy size of free space sfterthe pastition: & DME - 503273 MB

6. Complete the wizard and then apply the pending changes.

i

Apply pending changes 7

] . [

7. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.
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-9 )

System restart is required to complete the operation.
What would you like to do?

The operation Restore partition or disk needs exclusive access to the volums
C: and cannot be completed without system restat. After restart, the operation wil
contnue in bootime mode, Do not tum off the computer until the
operation completes.

PR

_; Restart the computer
Please confiem restart of your computer, The operation will be continued after
system restat

£ Retry
Manually close usad files and retry the operation

-

7= The operation cannot be completed without restart because some files are in usa and
((§ ) prevent exclusive access to the volume

8. Inthe Progress window you can see in real-time a detailed report on all actions carried out by the program.

After completing the operation the program will automatically reboot the computer.

This operation can also be accomplished with our recovery media.

A To make Windows bootable on different hardware, please additionally complete the P2P
Adjust OS Wizard.

Restoring a dual boot Mac from an external USB drive

Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk
on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Connect an external USB drive to the computer.
3. Restart the computer.

4. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to work with USB devices.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.
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5. Inthe Linux launch menu select the Simple Restore Wizard.

6. On the Wizard's Welcome page, click the Next button.

On the What to Restore page, click the standard browse button [...] to find the required archive. When done,
double click on it to select.

Select archive...

File mame: ||l.':-_ vista.pbi |

File type: [asenive fites = pbi v] | cancel |

< Back it Cancel |

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information
about the archive.

~ Disk preview

Volume [Type |File System |Size [Used [volume label |
Basic Disk 0 (Size 112 Ghb)

. Primary FATI16 00 Mb 15.0 Mb [Ma label

- Primary Apple HFS 549Ghb 14.2Gb lespard

. Primary HTF5 566 Gb 109 Gb [Ma label]
Aschive details: ~
Type: Image of the hard disk
Archive namea: ME0528hddNeo_vistaleo_vista pbi
Created; 2008 May 29 Thd 21:16:51 e

To contimue resiore process, click Next,

9. On the next page specify a hard disk to restore the image to.

Basic Disk 0 (VMware Virtual IDE Hard Dri

Basic Disk 1 (28)- 279 Gb
: NTFS ntfs4backup

[Basic Disko | Model Viware Virtual IDE Hard Drive, Size 112 Gb

N |volume |Type | File System |Size |volume label  [Active  [Hidden |
Basic Disk 0 {Size 112 Gb)

0 = Prirmary Fres 112Gh Mo Mo
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A All contents on disk selected for restoring purposes will be deleted during the operation.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next
button to initiate the restore process.

Vewchames on

Your partitions before operations:

- |

Your partitions after operations:

- Apple HFS leopard NTFS [Ho label]

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress
1: Restore parition or disk [! |
Operation progress
| |
Time elapsed:  00:00:16 Time o finish: 002624

Copied sofar: 1920 Mb Read so far 192.0 Mb(24.0 Mbys)
To copy: 14.0 Gb  Write o far 192.0 Mb(38.4 Mb/sh

Crverall progress

Convening disk 0 o GPT

Opening archive beo_vista_0000p 000..

Restore Primary partition O (disk 0) from file: /r90528hddleo_vistaleo_vista_0000p 000
Duata writing

Opening archive leo_vista_0001p 000

Restare Primary partition 1 (disk 00 from file: /19052 8hddleo_vistalea_vista_0001p 000
Doata writing...

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot,

please do the following:
1. Connect the second hard disk to the computer.

2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.
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3. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
5. Onthe Wizard's Welcome page, click the Next button.
6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

W My computer

' / (Rootdin

W MyComputer (My computer)
M /mnt (Mounted resources)
' /mnydisk (Local disks)

E W /media (Removable disks)

& IDE CD/DVD (NECVMWa VMware IDE COR1
~ EYEX TR
“@* D)\ (NTFS, 1on 2isk 0) (Application)

e E\ (BackupCapsule, 2 on Disk 0) (UFSD di:
T nudr [~

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
(77 /mnydisk/hdal/Documents and Settin [‘ Jsel E
(3 imndiskmdalDocuments and Settin o A
J Application Data
J Cookies
@ ) Deskiop
' ) E-Mail Database
@ J Favorites
_J Local Settings
J My Documents
. NetHood
) PrintHood
< > ) Recent v
Totaldata size: nfa [ Cak ] [ Rename (F6) ] [ Delete (F® ]

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.
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Please select how would you like o save the data:

(% Save data to any local drives or a network share
Choose this option il you want 1o $ave your data o lbcal
mounted or physical panition, 0 USE or FireWare external
drives and to a mounted network share, You will be prompted o
choose a location you want i sawve the archive o,

) Burn data to CO/DVD
Choose this option il you want the Wizand w burm the data o

CDor DVD. You will be prompied 1o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse
button [...].

Select path

limnydisihdaz ”:I

Space avallable on destination: 8.6 Gb

Totaldata size. nfa Calk

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress

l?T'dﬂ*llﬂG’dﬂl :Ii“...ll.'.l....llll.ll‘ll-.-.lll.ll...'illll..l..ll‘]

Operation progress

lonl'l-i'-u-.--l-'lbcnuuuunliicnnu'--n-.u-u-un-n-nllll

Time elapsed:  00:00:03 Time w finish 00:00:00

Copled so farr  17.0 Mb

Overall progress

T T T T T T T T

Transfering “/mntdisk/hdal/Documents and Settings/User/E-Mail Database” © “/mntdisk/hd a2/E-Mail Data
Transfering "/mntdisk/hdal/Documents and Settings/User/My Documents® to “/mntdisk/hda2/My Document
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Burning of data from the corrupted system disk to CD/DVD

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the
following:

1. Start up the computer from our Linux/DOS recovery media.
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Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that
enables to burn CD/DVD discs.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

Source

i My computer
™ / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
W /mnydisk (Local disks)
E W /media (Removable disks)
0' IDE CD/OVD (NECVMWa VMware IDE CDR1
- EYETeTT—
“e* D)\ (NTFS, 1on 2isk 0) (Application)
e E\ (BackupCapsule, 2 on Disk 0) (UFSD di:
T nudr v

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard Source
(7 /mnydisk/hdal/Documents and Settin I‘ Jser q
(3 imndiskmdalDocuments and Settin o A
) Application Data
) Cookies
@ ) Deskiwop
' ) E-Mail Database
@ ) Favorites
) Local Settings
J My Documents
) NetHood
) PrintHood
< > ) Recent v
Totaldata size: nfa [ Cak ] [ Rename (F6) ] [ Delete (F8 ]

Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item.
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Plaase select how would you like 1o $ave the data

()} Save dala ta any local drives or a network share

Chaose this option if you want o save your data o local
maunted or physical parition, o USB or FireWare external
drives and o a mounted network share. You will be prompied w0
choose a locathon you wanm o save the archive

(%) Burn data to CO/DVD

Choase this optian if you want the Wizard o burn the data o
CD or DVD. You will be prompted to choose a CD or DVD RW
drive.

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label
by entering it in the appropriate field.

Sebect a recorder w0 burn data v

Vendor |Product |Tvpe |
Optiarc DVD RWAD-T1704 CD-R; CD-RW, DVD-R
Volume label |M',.l Datd I

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress
[
1: Transfer userdata | |
Operation progress
[(TIITTITITITTI J
Time elapsed.  00:00:07 Time 10 finish: 00:00:16
Copied sofar. 5.0 Mb
To copy: 12.0 Mb
Overall progress
é,:!_ﬂ_lﬂ!hllll.ﬂil’ ]

Creating compilation image

Used burner: DVD RWAD-7170A Vendor: Optiarc
Session opening

Data burning...

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Copying of data from a backup to the corrupted system partition

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy
these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.
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Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.

Source

)

) DIFF128565184 710000000
e apc_2BOSOB1347) 7531 PRF
= arc_280508134627531 pim

6. Double click on the required backup to open.

Source

) -
i | Dacume%; and Settings
I Program Files

) RECYCLER

—J Sysem Volume Information
) WINDOWS

= cfiles svigz

= AUTOEXEC BAT

=) NTDETECT.COM

ﬁ bootini

E nitkdr 7

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
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Clipboard Source

(] WINDOWS/system (mnidisk/hda2/8 [wiNpow ]

) provisioning
) pss

) repair

) security

J srchasst

) system

) sysem32
J twain_32

= okog

= 001947_1mp
2 ; ERL "

(B,

Total data size: 904 Kb

Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

Please select how would you like o save the data:

(%) Save data to any local drives or a network share
Choose this option il you want 0 save your data o bcal
maumted or physical panition, 1 USB or FireWare exernal
drives and to a mounted network share, You will be prompted o
choose a lecation you want i sawve the archive 0.

) Burn data to COYDVD

Choose this aption il you want the Wizard © burn the data w
CDor DVD. You will be prompied o choose a CD or DVD RW
drive.

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard
browse button [...].

g _ [
0 INtServicePackUninstally

2 AppPatch

) Config D

) Connection Wizard

) Cursors

=) Debug

) Downioaded Program Files
) Driver Cache

i EHome -

Frerame (F6 [ Mew folder (F7) ]

File name: ] mintidisk/hdal WINDOWS | Select |

|
File type: ] I files (.4 | Cancel
Help < Back il Cancel

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
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Operations list Suboperation progress

1: Transfer user data

Operation progress

Time elapsed:  00:00:04 Time w finish: 00:00-00

Copied so far: 0.9 Mb

Crverall progress

Transiering “AVINDOWS/system” 1o "/mnydisk/hdal WINDOWS [system” - em 1 of 1
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with our recovery media.

Restoring separate files and folders from a backup

The program provides a very convenient option to access backup archives and restore only data you need (the so called
selective restore functionality).

Restore Wizard

To restore separate files and folders from a backup image with the Restore Wizard, please do the following:

1. Start up the computer from our WinPE recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

f CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Once you accept the agreement, you will see the Universal Application Launcher. Select the Restore Wizard.
3. Onthe Restore Wizard's Welcome page, click the Next button.

4. On the Browse for Archive page choose the required archive in the browser-like window. The Archive File
Details section displays a short description of the selected image.
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Lookin: | P Backuo Capaueon Hard Dk 0w ) 9%

Nare Sze  Date Al
T | ERl N{/TOBATe2 X (-2dce-S30 /- TX2coURSaZIZICITU /U 730 INE IETUPN
mg_0_310708_072005875 PBF 227KB 7/30/2008 3:20:10 PM
=- B N{71cb6d 16-4 ¥0-4dce-8367-1 ¥ 2cb (Fa 5321200831070 7/30/2008 3:52:28 PM
' mg_0_310708_075228187 PBF 227KB 7/30/2008 3:52:28 PM
8 B mo_1_310708_075228187 PBF 1.7GB  7/30/2008 3:55:41 PM
mg_2_310708_075228187.PBF 12GB 7/30/72008 3:57:46 PM =
Fles of type: | Archive files =]
Acchive Fle Datals
| Name: Local Disk (*)

Comment:  [No commant is avaiable!
Volume labal: WnXP

Fia systam:  NTFS Totalsize: 23GB
Used space: 19GB Free space: 10207 MB
Fla: “13¥2cbfa5d2j20083107075228187/mg_1_310708_075228187 PBF

5. On the next page specify what you need to extract from the backup by marking checkboxes next to the required
data items. At the right lower corner of the window you can see the resulted amount of the selected data.

Cick the check box next to any fie or folder you want 1o restore from

Name |Twe [Sze. |
= @9 Local Disk (7 Padtion  23GB
5

[~ & acnD8
-7 £ Documents and Settings
| -

+

[ B0 A Users
3 [ 55 Defaut User
4 7 £ LocalSanvice

-

- * Network Service
5V B User =
) 1 Applcation Data
Y ) Cookies
+ ) Desktop
; | Favontes

1 Local Settings

My Doames

T I

o8

“ 3 NetHood

o “ PrrtHood

+ | Racent

- ™ CandTa ;I
To cortnue. chck Next Data size 1o restore; 1.7 KB

6. On the How to Restore page specify the way the selected data will be restored. In our case we’d rather restore
contents of the backup to its original location with replacing existing files as well.

7. On the Restore Summary page review all parameters of the operation and modify them if necessary.
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Pleass overview the nestorss options. You can retum 1o the comesponding page and changs the options by cliking
on lithe hypedinkcs.
Objscts to Rastoos

Object (s) selected: 1

Total data size: 1.7 KB (1,743 Bytes)

Qriginal nestore destination
Destination path: Cu
Space available on destination: 1 GE (1,057 545 55€ Bytes)

8. On the next page of the wizard confirm the operation by selecting the appropriate option.

~Would you lics to apply your changas 7-
= [fes, apply the changss physicaly. |
Mo, let me recongsdes.

9. Inthe Progress window you can see in real-time a detailed report on all actions carried out by the program.

10. After completing the operation close the wizard, and then reboot the computer.

A This operation can also be accomplished under Windows.

File Transfer Wizard
To restore separate files and folders from a backup image with the File Transfer Wizard, please do the following:

1. Callthe popup menu for the required backup image (right click of the mouse button) in the Archive Database
and then select the menu item: Restore File from Archive. Thus you automatically open it with the File Transfer

Wizard.

T Show ot ] @ & @& % ‘

:Type Creation Date  ~ Source Object Size Rags ‘i‘

I[J §/3/2003 7:45:37 AM  Fledevel Archive 1368KB J& =1 ‘
9/3/2009 7:38:58 AM  Fledevel Archive 1368KB ¢ =}

$/3/2009 7:10:36 AM

F

e 9/3/2009 3.57:21 AM

) 9/2/2009 5:24:27 AM

e 9/2/2009 5:20:25 AM

(LJ 9/2/2009 5:11:41 AM
J 9/2/2009 5:06:03 AM

& 9/2/2009 2:33:00 AM

9/2/2009 2:21:01 AM

Local Disk (" Add an Archive to the Database... 2468 § o
Basic Hard [ Delete the Archive from the Database... | 1ngp - =
New Volume > 24GB ::l
¢ Restore Files.. 2
Fledevel Ac & 11KB =
Fledevel Arc @ Incremental File Backup... 4KB -
Local Disk ¢ - Re:‘kme File From Archive 39.9GB - |
Basc Had [ 1068 =2 =

2. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
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Qlipboard Source
Nome  Source Path | | Mame
= images /C/Users/user/Desktopimages” [C-/anc_images... = | anchive phi
= "_l,'
=1 [ -c
=[] Users
@] - [l umer
» =[] Desktop
;

Total data size: 412 KB

3. Onthe Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

There are several ways the Wizard can store your data. Plase select how would you lice to save the data
@) | Sawe data to local/network drives. |

Save data o physical paditions

Buer the data ta CD er DVD.

On the Select Destination Path page, specify the exact place to copy the data to.
Please select the destination path where to save the data from cipboand
Loak in: B Local Desk (C) n B ok ¥

Address: o/

.Nm
=[] Local Disk (C3)

# |, are_images

L BT _NEW

H- |, archdb

| archive db
Total data size: 412 KB
Space avalable on destination: 489 8 GB

On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.

Please ovenview the transfer options. You can retum (o the comesponding page and change the oplions by
chicking on title hypedinks.

Objects to iransfer
Object(s) selected: 1
Total data size: 412 KB (421,989 Bytes)

Trangler degtination
Destination path: Csf
Space available on destination: 4858 GB (525,927 415,504 Bytes)
Owerwrite existing files: Mo

6. After the operation is completed, close the wizard by pressing the appropriate button.

Volume Explorer

To restore separate files and folders from a backup image with Volume Explorer, please do the following:

1. Click the Disk View tab and then choose Volume Explorer;
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Disk View  Scheduled Tasks | Archives | Heip |
Hame Size Modfied
@ EICD/OVD Drives |
&1 & Hard Disks
2 [Z] 1. Vhiwars, VMwars Vitual 5 SCSI Disk Davi 500GH
& @ 1. Primary NTFS [T} 439.9GB
- [Z] 2 Viwans, Viwars Vitual § SC5I Disk Devi 0GB
& [5] 3. VMware, VMware Vitual 5 SCSI Disk Devi 20 GE
£ -8 1. Prmary NTFS (5 415GE
@ 2. Backup Capsule 8GR
5 & [5] 4. VMware, Viware Vitual 5 S5CSI Disk Devi {GPT Disk)
& I Virtuad Drives

2. Browse for the required archive and then open it by double click of the left mouse button.

Disk View  Scheduled Tasks | Archives | Help |

MName Size Moddied
2 [E] 3 VMware, VMware Vitual S SCSI Disk Dewi BOGE
=1 Primary NTFS (G) 419GE
) are_disk2 922009 4:25:00 AM
& o arc_doc 9/2/2009 4:05:42 AM
B are_images 9/2/2009 £:45:37 AM
B arc_system /272009 1:41:04 AM
:g | | ane_system 001 1.8GE 9202009 1:47:04 AM
=8 B arc_system PEF 19GE 97272009 1:37:32 AM
5 1. Patiion 4599G8
[ are_system pem 156 Bytes /202009 1:41:03 AM
|| anc_gystem pim B6IKE 9272009 1:41:04 AM
- £ System Volume Information S/2/2009 4:42:59 AM
[ 2. Backup Capsue |G

@ [Z] 4. VMiware, VMware Vidual S SCSI Disk Devi (GPT Disk)

3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.

4. Select a place on the disk where the file/folder will be extracted to.
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Look in [5] Local Disk () ] @ ® ¥
@] Address: | C./
ek Db Hame Date
-

+ BC_images LTl )

@ * ac_rew il

Mtwede Places + archdb YXH

5 | archive db N

[ Pedlogs T

% | Program Fles A

¥ sarg = I P

# Lhils amnms

+ Windows 2

5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume
Explorer.

Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the
only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to
do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos,
favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily
tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:

1. Click the Express Create Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to
minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to
do is to choose between several modes. The most relevant thing here is the amount of space that will be
allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by
selecting this or that mode.
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The resut you will gat after appiying the changes

Basic Hard Disk 0 (VMware, VMware Virdual S SCSI Disk Dey)

l lq_))uenvauncw)

Plaase salact the method of new pantition craaton
Take all unallocated space at the end of the disk

) LSam Mode | (Use 243.3 GBto create a pattion ) Moce nfo

Advanced Mode (Use 1414 GB o craate a patton ) More nfo

The number of available methods depends on your disk layout.
AN

To learn more on the way the wizard works, please click the corresponding link on the first
page of the wizard.

4. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

._? Express Create Partition Wizard ? Il
Creating the partition ;

\
The Wizard is now creatng the pantiion ‘ iii

Crests nastion

® Express Create Partition Wizard B )

; System restart is required to complete the operation.
/ &« \ What would you like to do?

The operation Move partition needs axclusve access 1o the volume C: and
Operatio cannct be completed without system restad. After restant, the operation will continue in

2 boottime mode. Do not tum off the computer until the operation
completes.

ES;—.* Restart the computer
Please confim restart of your computer, The operation will be continued after
system restant

& Retry

Manually closa usad filas and ratry tha oparation

prevent axciusive access to the volume
s £

@ The operation cannot be completad wihout restat bacause some fles ams in use and
What fles prevent operation completion?

5. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see the
newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.
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Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well.
This partition will later act as a space donor.
The wizard will rese space batwesn Local Disk (C:) 2nd New Volume (E:) on Basic Hard Disk O
(WMware, Viware Vitual 5 5C51 Disk Dev)
Sedact left partition from & pair of adjacent partitions you would e 1o resize, Right adipoent partiion will ba

Slgied Automalicaly

Basic Hard Disk O (WVMware, VMware Yirdeal 5 5051 Disk Dev)

H. I @) New Volume (E-)

If you’ve got more than two partitions on your hard disk and a partition you need to
Q increase is surrounded by other partitions, you’ve got the choice to choose which partition
will act as a space donor. Just click on the left partition of the pair, as the right one will be
selected automatically.

4. Increase size of the system partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Plaase spacfy new szes of salacted pattons

Selected part of Basic Hard Disk 0 (VMware, VMware Virtual 5 5C51 ik Dev)

I l 2] New Valume (E:)

Laf wolume size Right volurma size

40624 ME [ MB —{] aT1EEME 5| MB

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.
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A The VWizard has not applied your changes yet. On this pags, you can eithar accapt or
A racongider the changes

—

Please note that £ you accept the changes, the Wizard wil physically pefom ol the neccessary
operations and ¢ will not be possble 1o undo the changes

Rk may take some time to apply the changes. You may also be asked to restart your computer during this
process

Would you ke to apply your changes 7

Yes. 3pply the changes physicaly

6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.

’; System restar is required to complete the operation.
/= % What would you like to do?

The cperation Redistribule partitions nesds axciusive acosss 1o the voluma C;

and cannot be complated without system restad, After restad, the operation wil
cortinug in boctdme made. Do not bum off the computer until the operation
completes.

Ié: BRestart the computer
Please corfim resten of your computer. The cperstion will be continued sfter |

E» Rptry
Manualy closs used filas and retry tha oparation

[ Concet ]
7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.
After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But one of your
partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:

1. Inthe main window select the required hard disk (if several) on the Disk Map.

[5] Basic GPT Hard Disk 2 (VMware, VMware Vitual S SCSI Disk Dev)
@Lcca Disk () oh
€ (Unalocated) 473BFFBD

'Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev) |

' A.. Data (F:) I TEMP (G:)
‘ 10.., 200GB NTFS 1603 GB FATA2

m

~4

2. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.
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i Back Up Partiton...
Burn Partston on €0 or DVD...

Teols Changes Wizards Hard Disk Partition Archives Vi Restore Partition,..
@ & % ’:__}'_ 6 t_ﬂ' Format Partition...
| Disk View | Scheduled Tasks | Archives | Help | Delete Partition...
ol Mame . Move/Resize Part'tl'm‘. |
"I [E] Basic Hard Disk 0 (WMware. Vibwane Vitual S SC5I Desk Dev Convert File System...®
: B Local Disk (T)
) i Change Volurne Label...
& “opbeations (E) z C
= [ Edencdad Partition fmm& E_]'_“E =
E Data (F-} Hide Partition
@TEIJP G Make Partition Primary
il [] Basic Hard Diskc 1 (Viware, Viware Vitual S SCS1 Diskc Dev Change Cluster Size..
&l E_E:ITLT# . . Viwars Vitual 5 SCS1 D Change Senal Number...
- ._'-'I,Id S & LTINS, VTR NI 2 o " Change Partition I0...
- ﬁ Local Disk 7
B (Lnalocated) Wipe Partition...

Clear Free Space...

Test Surface...

| DN 5. Check File System Integrity

Basic Hard Disk 0 (VMware, YMware Virtual 5 5C5| Dish Edit/View Sectors...

A || Data (F:) 10 TEMP '. Properties... i
e 200 GB NTFS || 160.3GB FAT32 | | e ri:

In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing
this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by
entering the exact size of free space. Click the Yes button to continue.

Are you sure you want to move/resize volume (G:)?

You are about 1o move resize FAT32 volume TEMP, (G:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dev)
I @) (Unallocated) .“‘l @) TEMP (G)
1

595GE 00.7 GB FAT22
Volume size: 10316733 M8 #[+] 86 MB- 164.156 MB

Free space before: £0.928.55MB &[] Obytes - 164070.09 M8
Free space sfter. 0 Bypes *[=] Obytes - 164.070.09 M8

Select this option to move partiion areas that dont contain any data, This allows you to keep
the parition’s content after move exactly as & was, but will require more time

Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by
carrying out a number of extra move/resize operations.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

A.. ‘ Data (F:) I I TEM...
1. || I8 200GB NTFS . 100.7...
= = =

Since the block of free space is within the extended partition, you need to take it out first. The program enables
to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s
between two logical disks. So we need to move it. To do that, please select the first logical partition and then
call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
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'u* Vieﬁ ] Il Scheduled Tasks Move/Resize Partition.,

| Name Convert File System...

" 5] Basic Hard Disk 0 (Viware, VI Change Volume Label...
@ Local Dek (C) Remove Drive Letter
S;"“-“"’: ' Hide Partition

anded Fartton ols A
GD&B ) Make Partition Primary
@ (Unaliocated) Change Cluster Size...

2 &1ene G) Change Serial Number...
(8] (5] Basic Hard Disk 1 (Viware, VI Change Partition ID...
. @ Loca Disk 1) Downgrade NTFS version...
N [5] Basic GPT Hard Disk 2 (VMwat
Y 65.0\.8 Disk () Wipe Partition...

& Unatocated) Clear Free Space...

8 . J Test Surface...

‘i Check File System Integrity

Basic Hard Disk 0 (VMware, VI Fdt/View Sectars..

Properties...
Data (F:) -
. 200 GB NTFS J | L e I

6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the
partition size has been left unchanged.

Are you sure you want to move/resize volume (F:)?
= You are about to move/resize NTFS volume Data, (F:).

Basic Hard Disk 0 (VMware, VMware Virlual S SCSI Disk Dey)

@) (Unallocated) ©) Data (F)
119GB 1404 GB NTFS |

Volume size: 14387114 MB :~B 94 MB - 265,734 MB

Fres space before: |121.523.00MB &[] Obytes - 265,700.04 MB

Free space sfter. 0 Bytes *[] Obytes - 265.700.04 M8
] Sectorto sactor move

Selact this option to move padition areas that dont contan any data. This allows you to keep
the parition’s content after move exactly as & was, but wil require more time.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it
(right click of the mouse button) to launch the Move/Resize dialog.

A Call a context menu for the extended partition (with the blue border), not the logical one.

8. Inthe opened dialog shift the edge of the extended partition to the right.
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% Are you sure you want to move/resize extended partition on disk 07

 Basic Hard Disk 0 (VMware, VMware Vitual 5 SCS1 Disk Dev)

LN ez ) @) Data (F) @) TEMP (G:)
LEig 1404 GB NTFS 100.7 GB FAT32
Volume size 2¢703860M8 &[+] 247.038 MB - 368,969 MB

Fres space befors: | 121.530.84 ME ;EUHw-ELSEE.E‘MB

Fres space after 0 Bytes 5

L o T e,

Selact this aption to move partition arsas that don't contain any data. This allows you to keep
the partition’s content aftsr move sxactly as & was, but wil regpuins mos times.

9. The block of free space has been released.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Ap... (Unall...
100. 115GB

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the
block of free space adjoin the system partition.

Data (F:) I TEM...
1404GBNT... || B 1007..

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

(Unall... Ap... Data (F:) ITE'"-~
119G8 100 .. 140.4 GB NT... 1007.... |

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to
launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

','(\9‘ Are you sure you want to move/resize system volume (C:)?
T You are about 1o move/resize NTFS voluma [No label], (C:)

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

I @) Local Disk (C:)
152.7GB NTFS

Volume sze 162.547.31 MB #[¥] 11.680 MB - 162,543 MB

Free space before: | 0.57 ME &[] Obytes - 150,868 20 MB

Fres space after. [ Bytes =] Obytes - 150.260.39 MB
| Sectorto sector move

Select this option 10 move pantion aneas that dont contan any data, This allows you to
keep the partion’s content sfter move exactly 3s & was, but will require more time

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.
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T[S

Apply pending changes 7

T s o [

14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the
appropriate button to agree.

Increasing size of a system partition by taking unused space of an adjacent logical partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the Redistribute Free Space item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Select a volume you want to expand, i.e. the system one.

Chocse a volume to expand

Basic Hard Disk 0 (VMware, VMware Virlual S SCSI Disk Dey)

159

l @) New Volume (E:)
83.9GB NTFS

1) Capasty of the voume (C:)is 15.9 GB. The wizard can expand this volume up to 99.9 GB 2t the
epence of other volumes

4. Select a volume to take the space from, i.e. the logical one.

Selact volumes to take space from. Free space from that volume will be used 1o enlarge the volume you have

selected on the previous page
Volume Fle system  Type  Capaciy 'Usedspace 'Freespaoe | % Free
I =€) NTFS logcal 835GB 668MB  833GB

5. On the next page of the wizard you can specify size of the resulted system volume. Drag the slider or type in the
exact value to set the volume size.
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Your disk after the changes:

Basic Hard Disk 0 (VMware, VMware Vilual 5 SCS51 Disk Dev)

!;"J l.n.t_'..i Dfﬂ-c < ¢} New Volume (E-)
57.9GB NTFS 42 GE NTFS
Salect new size:

59,356 35 MB [+] 16.382 MB - 102.323.47 MB

I Cusent wolume size- 57.9 GB
The vohume size has been increased on 41.9 GB

6. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to
confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

R ==

Merging a system partition with an adjacent logical partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming
applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent
logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To merge a system partition with an adjacent partition, please do the following:
1. Inthe main window select the required logical volume on the Disk Map.

Basic Hard Disk 0 (VMware. VMware Virtual S SCSI Disk Dev)

Local Dis... |’ e e
15SGEN.. ||| g39G8 NTFS

2. Call the context menu for it (right click of the mouse button) to launch the Make Partition Primary dialog.

artiion i [
sume (E) ATDCCH ATFEDS
1 (VMwere, Vilhware Vidual 5 5C51 Disk Dev)

d) 13FFFFFh

Change Volume Label..,
Remove Drive Letter
Hide Partition

Make Partition Primary

Change Cluster Size...
Change Senal Number...
Change Partition ID...
Downgrade NTFS version...

Wipe Partition...

—— Clear Free Space...

) (VMiware, Viiware Vidual S 5C51 Disk Dev) Test Surface...

New Volume (E-) Y5 Check File System Integrity
839GE NTFS Edit/View Sectors..

3. Confirm the operation by clicking the Yes button. By default, our program works in the virtual mode of
execution, so you can either confirm all operations to let the program accomplish them or continue work in the
virtual mode.
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@ [ s
Q Are you sure you want to make the partition primary?
You are about to make the parttion (E-) New Volume, NTFS pomary.

.

4. Click the Merge Partitions item of the Wizards menu (any of the ways described earlier can also be used here).

5. Onthe Wizard's Welcome page, click the Next button.

6. Select a volume you want to expand, i.e. the system one.

On this page. you can choose a parition that will be expanded to include adjacent paition, Please note that R is
possibie to selact only FAT, FAT32 or NTFS parttions. You will not be abls to procead further f no adacent
partitions of these types are present on the disk

Basic Hard Disk 0 (VMware, VMware Virtual S5 SCSI Disk Devy)

I L. I ©) New Volume (E:)
1596. 839GB NTFS

Select a volume you’d like the first volume to merge with. Please note that all contents of the selected partition
will be placed into a specific folder after the merge operation is over.

Sedact an adiacent partition to mergs vith the targst pariion. This parition vwill be merged to the one you hane

selecied on the previous page. The contert of the second partition will be placed in 2 folder insids the resulting
partition

Basic: Hard Disk 0 (VMware, Viwae Vil 5 SCS51 Disk Dev)

l Wl |I @) New Vohme (E)
158G... || B39GB NTFS

Specify a folder name o keep contert of the selected partition
Folder Mame  menged_partition _conbent

8. Review the changes and complete the wizard.
Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to

confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual
Operations Bar.

7|,

Apply pending changes 7

Do not show this message again [ MNo

10. If you've got to do with the system partition resize, like we do in our case, you will be asked to restart your
computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

11. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.
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After completing the operation your computer will be automatically restarted back to Windows where you can see that
you have the merged volume now.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is
exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system
partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily
tackle this problem with Paragon Linux/DOS recovery environment.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a

2 CD/DVD disc or a thumb drive.
To automatically boot from the recovery media please make sure the on-board BIOS is set
up to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode
to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the
option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware
incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and
keyboard drivers. This mode has simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

=

3. Inthe Linux launch menu select Partition Manager. You can find it in PTS DOS as well.

4. In the main window select the required hard disk (if several) on the Disk Map.

Hand Disk  Parition Operations Wizands  Help

I- Basic Disk 0 (VMware Virpal - 120 Gb

1age of ha D: HTFS Data

ge of hard

| Disk fron

isk | | madel vMware Virual, Size 120 Gb
M [volume [Type |File System |Size |used [Free

Basic Disk 0 (Size 120 Gb)

[ I = Primany NTFS 444Gk B1Gb 36.2 Gb
1 D Primary NTFS 756 Gb 49 Mb 756 Gb

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch
the Move/Resize dialog.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



151

Basic Disk 0 (VMware Vinual) - 120 Gb

D: NTFS Data
Create an image of partition... Al-B

Burn an image of partition ko CO/DVD..

Basi Disk

[ m Type Restore partition from image._. AR E
Basic Disk 0 (Size 1 Copy panitien AT
o C Prima 6.2
1 D Prima reais AN 13
Foarmat... Al-F
Delete.. AlD
Wipe paritian AW

Clear free space

Unmount._. rl‘!

Madify 4

6. Inthe opened dialog set a new size for the partition by moving the slider or by entering the exact value in the

appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click
OK to continue.

Partition preview

New size: (8323 - 45434) Mb

::i: = Mb
Free space before: (0 - 37111) Mb
j Mb

Free space afier: (0-37111) Mb

5412 | Mb

Ll

H 1] E

7. Now you’ve got a block of free space to add to your data partition.

Baskc Disk 0 (VMware Virtual) - 120 Gb
_

8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the
Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

- Paniion prévies

New size: (8- 102101) Mb

U E

102101 | Mb

Free space before: (0 - 1020931 Mb

-
-

oMb

Free space afier: (0 - 102083) Mb

-
-

Mb
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10. Apply the pending changes.

Applying changes

Jl 2 pending operations
s Apply changes 7
: ™ [ ves || ™ | | Detaits
Undo all | |
[ Apply By ] | You have pending op

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress
1: Mave partitsaon I
2: Move partitson Operation progress
[T
Time elapsed:  00:00:58 Time ta finish: 01:35:42

Copied sofar:  248.5 Mb Read so far: 365.9 Mbx (7.8 Mby's)
To copy: 7.9Gb  Write so far: 251.2 Mb (46.0 Mbys)

Owerall progress

Data maving

Creating new partitson _.

Moving drive idev/sdad on hard disk 0

Scanning data structure (may be a few minutes)
{Restart enabled)

Data blocks calculating

Quick data moving ...

Resizing partitions of Apple Boot Camp

Let’s assume you’re a Boot Camp user who's got Windows XP as the second operating system. Initially allocated space
for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some
space from your Mac partition, thus redistributing the unused space between the partitions.

To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:

1. Click the Express Resize Partitions item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system)
partitions of your Boot Camp configuration.
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The wizaed vall 1ezize space batwesn Local Dizk [°) and WinkP [C:) on Hetained Bazic GPT Hard
Dizk 0 WMware Yirtual IDE Hard Drive]

Sedact beft parbivon fom a pair of adjacent partitions pou would ke to resize. Fight adiacent patition vall be:
zelected automatically.

Retained Bagic GPT Hard Dizk 0 VM ware Virtual IDE Hard Drive]

I I Local Disk [7) I I WinxP [C:]
54.8 GB Apple HFS 565 GEINTFS

On the disk map you can also see the GPT service partition (called EFI) as well as a 128-

megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just
?
for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note,
when you change size of one partition the size of the other will be changed as well, thus redistributing the
unused space between the partitions.

Please specify new sizes of selected partihons
Selected part of Hetaned Basic GPT Hard Disk 0 [VMware Yitual IDE Hard Drive)
l @) Local Disk (%) I I (7] WinXP (C:)
402 GB Aple HFS 71.1 GB NTFS
Left volume size: Right volume sze;
41250MB 3 MB {k 72895MB = MB
5.

On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

The Wizasd has not apphed pous changes yet. On this page, wou can edher accept o
reconsider the changes.

Pleass note that if you accept the changes, the Wizard vill physically pedom al the neccessary
operations and # will not be possible to undo the changes.

It msay take some time to apply the changes. You may also be asked o restat pour computer dunng this
PrOCEss.

‘Wiould you bike bo apply your changes 7
(2)|es, apply the changes physically. |
() Mo, et me reconsidar

6. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do
with the system partition resize, like we do in our case, you will be asked to restart your computer in a special
boot-up mode to accomplish the operation. So click the appropriate button to agree.
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System restat is required o complete the operation.
What would you ke to da?

The operabon Hediztnibute partitions needs exchesive access bo the volume C:
and cannot be completed withoul system restart. After restat, the operation il
continue i bool-ime mode, Do nol turn olf the computer unlil the opelation
completes.

-

'_:/ Bestart the computer
Please confirm restart of pour computer, The operation will be continued alter
syslern restar

5 Rety
Marually cose used hles and nslny the operabon

Cancal

7. Inthe Progress window you can see in real-time a detailed report on all actions carried out at the moment.

After completing the operation your computer will be automatically restarted back to Windows where you can see that
your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection
we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista +
Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system
independence these operating systems will be installed on different partitions. That is why we need to hide the first
system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing —
your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near
future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-
proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the
second operating system you need to repartition your drive first, as it requires a separate primary partition.

Install New OS Wizard

Q This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

1. Click the Install New OS item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.
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3. Select the appropriate option to create a new primary partition on your hard disk.

Whers would you ke to install an operating system?

© | want 1o create a new pamary parition to install 05
A new parttion will be created by using unallocated space of your hard disk or unused space of existing
pattions. I is tha most prefarable way as no system or usar's data will be affactad dunng the installation
process

| want to use an existing pamary parttion to instal OS

In casa creation of 3 new pamacy pantition is not possbie here are airmady four pamary pattions on the
disi) or not desirable, you are free to salact any of exsting pamary pattions. Please note that all data on

the selected partition will be deleted £ you choose to format & later in this wizard. Besides make sure no
operating system has already been installed on that padition

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free
space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If

not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

You can salect ether a block of unallocated spaca of the disk or an axsting padition, unusad space of which wi
be sarved 10 create 3 new panttion

Basic Hard Drsk 0 (VMware, VMware Virtual S SCSI Drsk Dev)

I @) Vista (C)) Il @) (Unallocated)
158.7 GB NTFS L_EAFLE:

[) MaxVolume Size: 3412GB

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to
install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

Partiion bype @‘-T"S 3
Aasign the following drive letter, | E :z]

Surmos test bevel: | Nore [

Q On this page you can specify a number of additional parameters that can also be of help.
However here we pay attention to the most relevant to fulfill our task.

6. Enter a label for the future partition in the textual field. It will later be used for the drive identification.

(05 labels will be displayed in the Boot Manager's startup menu to help you boaot the required operating
system.

05 label: |Windows ¥F|

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate

the installation process.

Q If you’ve changed your mind on installing a new operating system, don’t insert its
distributive CD but press ESC when the following message appears:
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listributive CDADUD and pre any kew to continue

to abort the action

Make sure your BIODS iz zet up to boot from CD/DUD.

All the mentioned above operations can also be accomplished with the WinPE recovery
environment.

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find
all the necessary information in documentation that comes with the product. However to avoid any problems,
we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;

- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first
or press F12 during startup to select a bootable device;

- Do not forget to select the newly created partition as destination.

Windows XP Profeszzional Setup
The following i : h t & ing partitionsz and
unpartitioned :
= UP and ARRC i 5 to lect an item in
To zet up Windows XP on the ed item,. press ENTER.
Te create a paprtition in the unpavrtitioned space. press

To delete the zelected partition,. press D.

238%91 HEB Dis B at Id B on bus on [MER1

E: Partitionl < active Boot MHanlB8%AA HE
i t t i T . i ": q

9. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows
Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do
that, please install our program once again, but this time in Windows XP to activate Boot Manager.

.A To avoid double installation, please use our recovery media to activate Boot Manager.

10. Click Boot Management and then select Boot Manager in the Express Launcher.

11. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the
wizard and it will automatically find the two operating systems and update the MBR.

Boot menu options

o Normal mode
V| Timeowt for booting last usad configuration 15 saconds
Hidden mode
Time to display the BootManager statup message

Choosa a hot key for stanup BootManager

12. Now restart the computer to make sure you have got a dual boot system.
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ﬁ This scenario implies that operating systems will be installed on different partitions to
provide better security and system independence.

1. Click Switch to Full Scale Launcher in the Express Launcher.

In the main window select your hard disk on the Disk Map to make a block of free space on it.

2.
~ Local Disk (E:)
Serial number:
Partition 1D:
NTFS version:
Volume Size:
Partition size:
Used space:
Free space:
Activity:
Hidden state:
§ Format Padition
@g This wizard haips you to fomat the salected parttion.
Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev) 1
Local Disk (E:)
433.9GB NTFS
3. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call

| Disk View | Scheduled Tasks | Archives | Help

Loci

Basic

Log

7 ]

&y Hard Disk Manager™

Are you sure you want to move/resize volume (E:)7?
You are about to move/resize NTFS volums [No labal], (E:).

| Basic Hard Disk 1 (VMware, VMware Viitual 5 SCS1 Disk Dev)

498.9 GB NTFS

455

‘. @) Local Disk (E)

Volume siza: 511.557MB  [=] 101 ME- 511,957 MB
Fres space before: | 0.97 ME %B Obytes - 511,891.42 ME
Fres space after: |0 Bytes T-E Obyt=s - 511,838.18 MB

[7] Sactorin sectormove
Salmct this option to move partition amsas that don't confain any data. This allows you to kesp

the partition's content after move sxactly as § was, but wil raguine more time,

the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.

Disk
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In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this,

4,
free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering

the exact size of free space. Click the Yes button to continue.

Are you sure you want to move/resize volume (E:)?
You are about to move resze NTFS volume [No label], (E:)

Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dev)

. ©) Local Disk (E:) ,_‘"_,I ©) (Unallocated)

268 3GB NTFS

274.730.513MB [&[=] 101 MB-511.333 MB

Volume size 274.790.5
Free space before: |0.37 MB s[w] Obytes-511.831.43 M8
Free space after: | 237.201.52MB  2[+] Obytes-511.883.61 MB
Sactor to sector move

Selact this option to move panition areas that dont contain any data. This alows you 1o keep
the pattion’s contert after move exactly as & was, but will require more tme

Q The Move/Resize dialog offers a number of additional parameters that can also be of help
However here we pay attention to the most relevant to fulfill our task.

5. Now you have a block of free space sufficient in size to hold a new partition.

'Basic Hard Disk 0 (VMware